Chapter 2

Working with Projects
and Drawings

Learning Objectives

After completing this chapter, you will be able to:
* Create new projects and drawings

* Edit the properties of projects and drawings

* Add drawing descriptions

* Open existing projects

* Activate and close projects

* Add existing and new drawings to the current project
* Group the drawings of a project

* Rename, replace, and remove drawings from projects
* Assign description to a drawing

* Open project drawings

* Copy existing projects

* Understand the working of the PROJECT MANAGER
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INTRODUCTION

AutoCAD Electrical is a project-based software in which wiring diagrams related to each other
are grouped under a project. A project is a set of electrical wiring diagrams that form a project
file <project_name>.wdp. Each project is defined by an ASCII text file with .wdp extension. These
project files contain a list of project information such as project settings, project or drawing
properties, names and descriptions of drawing files, symbol library paths, and so on. You can
have an unlimited number of projects. However, only one project can be active at a time. The
list of these projects is displayed in the PROJECT MANAGER.

PROJECT MANAGER

Ribbon: Project > Project Tools > Manager

Toolbar: ACE:Main Electrical 2 > Project Manager

or ACE:Project > Project Manager
Menu: Projects > Project > Project Manager
Command: AEPROJECT

E The PROJECT MANAGER is used to create new projects, open existing projects, add

new drawings to a project, re-order drawing files, access existing projects, and modify

existing information in a project. By default, the PROJECT MANAGER is displayed

and docked on the left of the screen, refer to Figure 2-1. If the PROJECT MANAGER is not

displayed by default, choose the Manager tool from the Project Tools panel of the Project tab;
the PROJECT MANAGER will be displayed.
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Figure 2-1 AutoCAD Electrical screen with the PROJECT MANAGER

Alternatively, choose the Project Manager tool from the ACE:Main Electrical 2 toolbar to display
the PROJECT MANAGER. The PROJECT MANAGER is similar to other AutoCAD Electrical
tool palettes. You can dock the PROJECT MANAGER at a specific location on the screen. Also,
if you do not want to use the project tools, you can hide the PROJECT MANAGER.
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The PROJECT MANAGER is divided into two tabs: Projects and Location View. The options
in both these tabs are discussed in detail in this chapter.

Projects TAB

In the PROJECT MANAGER, the Projects tab is chosen by default, refer to Figure 2-1. When
you double-click on the title bar of the PROJECT MANAGER, it gets undocked and is displayed
separately on the screen, refer to Figure 2-2. When you right-click on the title bar of the undocked
PROJECT MANAGER, a shortcut menu is displayed, as shown in Figure 2-3. You can change
the appearance, location, and display settings of the PROJECT MANAGER by choosing the
respective options from the shortcut menu.
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Figure 2-2 The undocked Figure 2-3 The shortcut menu displayed by
PROJECT MANAGER right-clicking on the title bar of the PROJECT
MANAGER

When you double-click on a project name in the Projects rollout, a list of drawings associated
with the project will be displayed. Also, the details of the selected project will be displayed in the
Details rollout of the PROJECT MANAGER, as shown in Figure 2-4. The name of the active
project will appear in bold text in the Projects rollout of the PROJECT MANAGER.

In AutoCAD Electrical, projects in the Project Manager are based on various drafting
standards such as IECDEMO, JISDEMO, GBDEMO, IEC60617DEMO, IEEEDEMO, and so
on. These projects are based on respective symbol libraries. For example, in the IECDEMO project
the drawings are based on IEC symbol library whereas in the IEEEDEMO
project, the drawings are based on IEEE symbol library. Detailed information
about various drafting standards is provided later in this chapter.
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When you right-click on a drawing name, a shortcut menu will be displayed. You can use the
options in this shortcut menu to open, close, copy, remove, replace, rename, or access other
editing options to modify the drawing file. These options are discussed in detail later in the
chapter. You can open a drawing file by double-clicking on it in the PROJECT MANAGER
and the corresponding drawing file name will appear in bold text in the Projects rollout of the
PROJECT MANAGER.
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Note
You cannot create two projects with the same name in the PROJECT MANAGER. Moreover by
using the PROJECT MANAGER, you can switch to different projects and change their settings.

Opening a Project
P You can open an existing project by using the Open Project button from the
~ PROJECT MANAGER. On doing so, the Select Project File dialog box will be displayed.
Next, select the existing project from this dialog box and choose the Open button; the
selected project’s name will be automatically displayed in the Projects rollout in bold text and
it will become an active project.

In the Select Project File dialog box, by default, the nfpaDemo folder is displayed
in the Look in drop-down list, refer to Figure 2-5. You can customize this folder. To
customize the default folder, open the windows explorer. Next, navigate to the location
c:\Users\User Name\Documents\Acade 2023\AeData) and open the wd.env file in Notepad. Now,
scroll down in the file and go to the line highlighted in blue, refer to Figure 2-6. In this line,
remove the “*” symbol available at the start of the line. Also, select the text “x:/some path/ and
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enter the desired path; the selected text is replaced by the desired path, refer to Figure 2-7.
Next, save the wd.env file.

Note
@ If you put any extra space at the start, in between, or at the end, the desired path will not change.

B select Project File x
Look in: NfpaDemo v 3 B Views w Tools
~
(,} - Name Date mc
| &] Nfpademo 1/21/20°
History
i Documents
|
\
: T
Favorites
Desktop
I
< >
| File name - Open
Files oftype: | Elactrical Projectfiles (" wdp) = Cancel

Figure 2-5 The Select Project File dialog box

) wd - Notepad - o X |

File Edit Format View Help

for "Quick pick" il

* Catalog Parts Database Path

WD_CAT,%WD_DIR%/%WD_LANGY%/catalogs/,AE catalog file path
*WD_XCAT,x:/some path/wd_xcat.Isp,to override catalog look-up and call user's external routine

* Project and drawing-related paths and settings

‘WD PROJ,%WD_DIR%/proj/,AutoCAD Electrical default project data folder

WD _PICKPRJDLG,x:/some path/,to override starting subdir for "PICK PROJ" butto)
*WD_OPEN_DWG,(command "_.ZOOM" "_E"),AutoLISP prog or expression to autoexecute when dwg opened
from PROJ dig

*WD_ZIP,c:/program files/winzip/winzip32.exe,full path/name of zipping utility executable
*WD_ZIP,c:/program files/WinRAR/rar.exe, full path/name for alternate zipping utility
'*WD_PROMPT_SAVE,1,set to 1 to trigger "Save changes" prompt when using open dwg next/prev arrows buttons

* Plotting & Reporting Path

*WD_PLOT2FILEDIR,X:/some path/,target dir for AutoCAD Electrical's Batch Plot to File
*WD_SAVE2FILEDLG,x:/some path/,default save directory for reports
*WD_SET_FILES,x:/some path/,folder for report ".set" files

* Menu & Slide Path v

Figure 2-6 The line highlighted in the wd.env file

Now, choose the Open Project button from the PROJECT MANAGER; the modified Select Project
File dialog box will be displayed, as shown in Figure 2-8. You will notice that the name of the folder is
changed.
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WD_CAT,%WD_DIR%/%WD_LANGY%/catalogs/AE catalog file path
*WD_XCAT,x;/some path/wd_xeat.Isp,to override catalog look-up and call user's external routine

* Project and drawing-related paths and settings

WD_PROJ,%WD_DIRY%/proj/,AutoCAD Electrical default project data folder
WD_PICKPRJDLG, /\to override starting subdir for "PICK PROJ" button

*WD_OPEN_DWG,(command "_ZOOM" *_E") AutoLISP prog or expression to autoexecute when dwg opened

from PROJ dig
“WD_ZIP, full f zipping utility
“WD_ZIP, full for alternate zipping utility

“WD_PROMPT_SAVE, 1,s¢t {o 1 to trigger "Save changes" prompt when using open dwg next/prev arrows buttons

* Plotting & Reporting Path

*WD_PLOT2FILEDIR,x:/some patly,target dir for AutoCAD Electrical's Batch Plot to File
*WD_SAVE2FILEDLG,x;/some path/default save directory for reports
*WD_SET_FILES,x;/some pathy,folder for report ".set" files

* Menu & Slide Path

*WD_MENU,%DS_DIR%/my_menu.dat,to override default schem icon menu
*WD PMENT.%DS DIR%/mvonimnu.dat.to override default nanel lavout icon menu

Figure 2-7 The selected text replaced by the desired path
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Figure 2-8 Modified Select Project File dialog box

Creating a New Project
Command: ACENEWPROJECT

F2 You can create a new project by choosing the New Project button from the
PROJECT MANAGER. On doing so, the Create New Project dialog box will be displayed,
as shown in Figure 2-9. Alternatively, use the ACENEWPROJECT command to create

a new project. Different options in the Create New Project dialog box are discussed next.
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Create New Project X

Name

Location:
‘ C:\Users\CADCIM1\Documents\AcadE 2023\AeData\projy | Browse

Create Folder with Project Name

Ci\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\

Copy Settings from Project File:
C\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemo\NFPAdemo wdp Browse...

Descriptions..

OK - Properties 0K Cancel Help

Figure 2-9 The Create New Project dialog box

Name

The Name edit box is used to enter a name for the project. On doing so, the .wdp extension will
be automatically added to the file name and displayed under the Create Folder with Project
Name check box.

Location

The Location edit box is used to specify the location for saving the project. You can also choose
the Browse button on the right of the Location edit box to specify the location for saving
the project file (.wdp file). By default, C:\Users\User Name\Documents\Acade 2023\AeData\proj| is
displayed in the Location edit box, refer to Figure 2-9.

Create Folder with Project Name

The Create Folder with Project Name check box is selected by default in this dialog box. As a
result, a folder with a name identical to the project name will be created. Also, the new project
will be saved in that folder. The path of the folder will be the same as that defined in the Location
edit box. If you clear the Create Folder with Project Name check box, a separate folder will
not be created for the project.

Copy Settings from Project File

You can also copy the settings from an existing project and apply it to a new project. To copy
the settings from the existing project file, specify the name and location of the existing project
file in the Copy Settings from Project File edit box. Alternatively, choose the Browse button on
the right of this edit box; the Select Project File dialog box will be displayed. Select an exist-
ing project file and then choose the Open button; the settings of the specified project will be
applied to the new project and the location of the specified project will be displayed in the Copy
Settings from Project File edit box. By default, C:\Users\User Name\Documents\Acade 2023\AeData)
Pproj\NFPAdemo\NFPAdemo.wdp is displayed in the Copy Settings from Project File edit box.
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Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-8 AutoCAD Electrical 2023 for Electrical Control Designers

Descriptions

The Descriptions button is used to add a description to the project. Choose the Descriptions button;
the Project Description dialog box will be displayed, as shown in Figure 2-10. In this dialog
box, you can enter a description of the new project up to 12 lines per page. If you want to add
more than 12 descriptions, click on the > button at the bottom of this dialog box. To include
the description in the reports, select the in reports check box on the right of each description
line. Note that the descriptions thus added will be included in the report headers of the report
file and the title blocks of the drawing. Now, choose the OK button from this dialog box to save
the changes made and exit the dialog box. The concept of report generation, title blocks, and
Project Description dialog box is discussed in detail in the later chapters.

OK

The OK button of the Create New Project dialog box will be activated only if you enter the
name of the project in the Name edit box. Choose the OK button; the project that you created
will be added to the current project lists in the PROJECT MANAGER. Also, it will become an
active project and its name will appear in bold text in the PROJECT MANAGER.

OK-Properties

The OK-Properties button will be activated only if you enter the project name in the Name
edit box. Choose the OK-Properties button; a new project will be created and the Project
Properties dialog box will be displayed. This dialog box is used to modify project settings,
components, wire numbering, cross-references, styles, and drawing formats. All information
defined in the Project Properties dialog box is saved to the project definition file (.wdp) as
project and drawing defaults. Next, choose the OK button from this dialog box to exit from it.
The options in the Project Properties dialog box are discussed later.

Project Description (for report headers and title block update) X
Title 1: | | [lin reports
Title 2: | | inreports
Title 3: | | [lin reports
Job Number: | | [in reports
Date: | | [Cin reports
Engineer: | | [in reports
Drawn By: | | [Cin reports
Checked By: | | [ ]inreports
Scale: | | [in reports
Lina10 | | [inreports
Linell | | [in reports
Line12 | | [Cin reports

Cancel |« < > >

Figure 2-10 The Project Description dialog box



Working with Projects and Drawings 2-9

Note
@ You can also create a new project by right-clicking inside the Projects rollout and then choosing
~ the New Project option from the shortcut menu displayed or by selecting the New Project option
Sfrom the Project selection drop-down list in the PROJECT MANAGER. You will learn more
about it later in this chapter.

Working with Drawings
In the previous topic, you learned to create new projects using the PROJECT MANAGER. Now,
you will learn to create new drawings within an active project.

You can add any number of drawings to your project at any time. A project file can have
drawings located in different directories. But, it is recommended that you save your drawings
and project file (.wdp) in the same folder. When you create a new drawing, an invisible smart
block, WD_M, will automatically be added to your drawing at location 0,0. The WD_M block
defines drawing settings. These settings may be different from the project settings. Thus, you can
have different settings for different drawings in a single project. Also, each AutoCAD Electrical
drawing should contain only one copy of invisible WD_M block. If multiple WD_M blocks are
present in the drawing, the settings may not be stored and read consistently. Also, note that the
drawing to be created will automatically get added to the active project.

Creating a New Drawing
Command:  ACENEWDRAWING

5 The New Drawing button is used to create a new drawing file. To do so, choose the New
Drawing button from the PROJECT MANAGER; the Create New Drawing dialog box
will be displayed, as shown in Figure 2-11.

Alternatively, invoke this dialog box by using the ACENEWDRAWING command or by
right-clicking on the Projects rollout of the PROJECT MANAGER and then choosing the
New Drawing option from the shortcut menu displayed. The different areas and options in
this dialog box are discussed next.

Drawing File Area

The options in the Drawing File area are used to specify the name of a drawing file, the
template file to be used in the drawing, the location to save the drawing, and the description
for the new drawing file. The options in this area are discussed next.

Name: Enter a name for the new drawing in the Name edit box; the .dwg extension will
automatically be added to the drawing name. Note that the OK and OK - Properties buttons
will be activated only after entering the name of the new drawing in this edit box.

Template: This edit box is used to specify the path and name of a template drawing (.dwt)
for creating a drawing file. Alternatively, you can choose the Browse button; the Select
template dialog box will be displayed. Select the template drawing from this dialog box
and choose the Open button; the location of the template drawing will be displayed in the
Template edit box.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Create New Drawing X

Drawing File
Name: “ |

Template: ‘ | Browse...

[For Reference Only

Location: ‘C:\Users\CADC\Ml\Documems\f-\cadE 2023\AeData\proj\NFPAdema | Browse...

C:\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\NFPAdemo

Description 1: ‘ V|
Description 2: ‘ V|
Description 3: ‘ v|

|IEC - Style Designators

Project Code:

Installation Code

| | Drawing.. Project..

Location Code:

| | Drawing.. Project..

SheetValues

Sheet | | Section | \/‘

Drawing: | | Sub-Section | V‘

OK - Properties... QK Cancel Help

Figure 2-11 The Create New Drawing dialog box

. Note
@ After specifying the template in the Template edit box, next time when you create a new drawing,
the template entered previously will automatically get displayed in the Template edit box. If this
edit box is left blank, AutoCAD Electrical will use the default acad.dwt file.

For Reference Only: The reference drawings are used for coversheets, terminal plans,
and other non-electrical layouts in a project. These drawings save the processing time of
AutoCAD Electrical functions. To create a reference drawing, you need to select the For
Reference Only check box. On doing so, the reference drawing will be included in the
project-wide plotting and title block update operations. All other electrical smart functions
such as cross-referencing, automatic tagging, reporting, and so on will be non-functional.
By default, the For Reference Only check box is cleared.

Note
The color of the reference drawing icon displayed on the left of the drawing name in the
PROJECT MANAGER s gray.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

Location: The Location edit box is used to specify the location of a new drawing. The
directory of the active project file is specified by default in the Location edit box. Alternatively,
choose the Browse button on its right to specity different location for the new drawing. If you
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leave the Location edit box blank, the drawing file will be created at the same location as that
of the active project. Note that you cannot create duplicate drawings at the same location.

Description 1-3: The Description 1, Description 2, and Description 3 edit boxes are used
to enter description for a drawing. In these edit boxes, you can enter up to 3 description lines
for a drawing file. You can also specify the description for a drawing by selecting it from the
description drop-down lists. But this is possible only if you have entered description in the
earlier drawings. The description thus entered will be displayed in the title block updates
and custom drawing properties.

OK

The OK button will be activated only if you enter a drawing file name in the Name edit box.
When you choose the OK button, the new drawing gets automatically added at the bottom
of the list in the active project and it appears in bold text. To view the drawing file, expand
the active project by double-clicking on the project name.

OK - Properties

The OK - Properties button will be activated only if you enter a drawing name in the Name
edit box of the Drawing File area. Choose the OK - Properties button; a drawing file will
be created at the specified location and also the Drawing Properties dialog box will be
displayed, as shown in Figure 2-12.

This dialog box is used to define settings and options for a drawing. The options in the
Drawing Properties dialog box will be discussed in the later chapters. The changes that you
make using this dialog box will be saved as attribute values on the drawing’s invisible WD_M
block. Choose the OK button from the Drawing Properties dialog box; the drawing will be
created and will appear in bold text at the bottom of the project list of the active project in
the PROJECT MANAGER.

Note

@ Mentioning information in the Description edit boxes, the IEC-Style Designators area, the
Sheet values area as well as choosing the OK - Properties button is optional. You can also edit
any of these fields later in the Drawing Properties dialog box.

Tip

Q The IEC style designators are widely used when you are using the IEC drafting standard.
You must be aware of the drafting standards used in AutoCAD Electrical. The software
has been designed to use seven International Drafting Standards which are listed below:

1. Joint Industrial Council ---- J[ICI1/JIC125 (USA)

2. International Electrotechnical Commission ---- IEC2/IEC 60617 (Europe, UK)
3. Japanese International Standard ---- J1S2 (Japan)

4. Guobiao Standard ---- GB2 (Chinese)

5. Australian Standard ---- AS2 (Australia)

6. Institute of Electrical and Electronics Engineers Standard ---- IEEE 315/315A
7. National Fire Protection Association Standard ---- NFPA (USA)

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Drawing Properties X

Drawing Seltings Components Wire Numbers Cross-References Styles Drawing Format

Drawing:  C\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\NFPAdemo\demo02.dwg

Drawing File

Project: NFPADEMO

Description 1 ‘}phase motor control, Control circuit ~ | Picks>
Description 2: ‘ ~ | Pick>>
Description 3: ‘ ~ | Picks>

[ IFor Reference Only

IEC - Style Designators

Project Code

Installation Code:

| | Drawing.. Project.
Location Code:

| | Drawing.. Project.
Sheet Values

Sheet |2 | Section | -]
Drawing: |0202 | Sub-Section: | v]

Figure 2-12 The Drawing Properties dialog box

Adding a New Drawing to the Inactive Project

You can add a new drawing to the inactive project using the PROJECT MANAGER. To do so,
choose the New Drawing button from the PROJECT MANAGER; the Create New Drawing
dialog box will be displayed. Enter the required information in this dialog box, as explained
earlier and then choose the OK button; a new drawing will be created. Also, this drawing will
be automatically added to the active project and will appear in bold text at the end of the
Project Drawing list. Next, to add this drawing to an inactive project, right-click on the inactive
project name and choose the Add Active Drawing option from the shortcut menu displayed;
the Apply Project Defaults to Drawing Settings message box will be displayed, as shown in
Figure 2-13.

Apply Project Defaults to Drawing Settings X

Do you want to apply the Project Default Values to the Drawing Settings?

Yes No Cancel

Figure 2-13 The Apply Project Defaults to Drawing Settings message box

Choose the Yes button from the Apply Project Defaults to Drawing Settings message box; the
default values of the project will be added to the WD_M block definition of the newly added
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drawing. If you choose the No button, the new drawing will retain its existing settings. Choose
the Cancel button to exit the command.

Note
You can have a single drawing in multiple projects.

Adding Existing Drawings to the Current Project

You can also add the existing drawings to the current project. To do so, right-click on the project
name in the Projects rollout of the PROJECT MANAGER; a shortcut menu will be displayed,
as shown in Figure 2-14. Choose the Add Drawings

option from the shortcut menu; the Select Files to W RERCHREE®-

Add dialog box will be displayed, as shown in % @&nraneuc M
Figure 2-15. In this dialog box, select the desired Projects = g
project folder from the Look in drop-down list and 'Eﬁm!""'c!l'[:;e‘ :

. . EE EX
then select drawings to be added to the project. Next, Fict  ExpendAl

choose the Add button; the Apply Project Defaults to PR R Collapse A

Drawing Settings message box will be displayed, mFQ I Add Subfolder

refer to Figure 2-13. Efier  Fatten Structure
Descriptions...

Ifyou choose the Yes button, the default values of the Title Block Update...

project will be added to the WD_M block definition oot Ac Drawing List Report..

of the newly added drawing. But if you choose the Flip DWG Name to Lower Case

Details

. . L . ion:  Flip DWG Name to Upper C
No button, the new drawing will retain its existing o] b O Rameto Tppertase
M . . o
settings. Also, the selected drawings will be added to G [WrolNFE rawing
your project and will appear at the end of the Project g o sy
Drawmg hSt. 5 \CADCIM Add Active Drawing
g ‘Autodes| Remove Drawings...
2 2023\R24
NOte = \NFPADE| Task List...
W You can select multiple drawing files at a time from B Publish >
the Select Files to Add dialog box by pressing the Settings..
SHIFT or CTRL key. Exception List..
Properties...

Working with Project Drawings

You can group drawings, remove drawings,
assign description to drawings, preview drawings,
configure the drawing list display, and so on by using
the PROJECT MANAGER. Also, you can access the
existing project and modify its related information using the PROJECT MANAGER.

Figure 2-14 The shortcut menu displayed
by right-clicking on the active project name
in the PROJECT MANAGER

Grouping Drawings within a Project
You can group the drawings in a project in two ways: grouping using section/subsection and
grouping using subfolders. These methods are discussed next.

Grouping Drawings Using Section/ Subsection

You can create a group of drawings within a project list by assigning the section and
sub-section codes to each drawing. To do so, expand the project by double-clicking on its
name, if it is not already expanded; the drawings in that project will be displayed. Next,

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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right-click on the drawing file; a shortcut menu will be displayed. Choose Properties >
Drawing Properties from the shortcut menu; the Drawing Properties dialog box will be
displayed, refer to Figure 2-12. In this dialog box, the Drawing Settings tab is chosen by
default. Enter the required section and sub-section codes for the drawing in the Sheet Values
area and choose the OK button; the section and sub-section codes will get assigned to the
drawing file. Similarly, you can repeat the same procedure for each drawing that you want
to group together, but ensure that the same section and sub-section codes are assigned to
all of them.

B select Files to Add X
Look in hfpaDemo v A L} Views ~ Tools
- [ Name - Preview
L e ey .
= B8 pEMOOT
History B DEMOO2
. B DEMOO3
E B8 DEMOD4
Documents B_DEMODS
B DEMOOE
X & DEMOOT7
Favorites E_DEMODB
B DEMOD9
Deskiop
< >
File name | — Add
Files of type: Drawings (*.dwg) ~ Cancel

Figure 2-15 The Select Files to Add dialog box

Grouping Drawings Using Subfolders

You can create subfolders within a project to organize the drawings. To create a subfolder,
right-click on the project; a shortcut menu will be displayed. Choose Add Subfolder from
it; a subfolder with the name NEW FOLDER will be created at the bottom of the drawing
list. Rename it with a suitable name. Now, you can drag and drop the drawings available
in the project into the subfolder. When you right-click on the subfolder; a shortcut menu
will be displayed. The options in the shortcut menu are used to create and add drawings,
rename the subfolder, and so on. You can add any number of subfolders in a project. Also,
you can add subfolders within a subfolder.

You can also remove all the subfolders from an active project. To do so, right-click on an
active project and choose Flatten Structure from the shortcut menu displayed; the Flatten
Project Structure message box will be displayed warning you that if the process of flattening
is continued, you will not be able to revert back the changes again. Note that when you use
this option only subfolders are removed and the drawings are retained in the project.
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After creating a group of drawings and subfolders, the project-wide tagging, cross-referencing,
and reporting functions can be performed on the whole project or a part of the drawing set,
using the section, sub-section coding, and subfolders.

Changing the Order of Drawings in a Project

In the Project Drawing list, the drawings created are arranged in the same sequence as they are
processed by AutoCAD Electrical during the project-wide tagging and cross-referencing operations.
However, you can change the order of the drawings present in a project by dragging and dropping
the drawings at the required place in a sequence. You can also reorder the drawings by moving
them between two subfolders of a project. Note that you cannot reorder the drawings by moving
them between two projects. You can press the CTRL or SHIFT key to select multiple drawings.

You can also sort the drawings in a project to change their order. To do so, right-click on the
project name and choose the Sort option from the shortcut menu displayed. If the project
contains subfolder(s), the Sort Options message box will be displayed showing four different
combinations of options to sort the drawings in the project folder and its subfolder(s), refer to
Figure 2-16. Choose one of these options as per your requirement; the Sort dialog box will be
displayed, as shown in Figure 2-17.

Sort Options X

o How would you like to handle the subfolders?

There are several different combinations of options to choose from when dealing with subfolders
during a sort:

—> Move folders to top, sort files in this folder only
—> Move folders to top, sort files in this folder and subfolders
—» Move folders to bottom, sort files in this folder only

- Move folders to bottom, sort files in this folder and subfolders

O Always perform my current choice Cancel

Figure 2-16 The Sort Options message box

You can sort out the drawings in different ways depending upon the options selected from the
Sort dialog box. You can select the required option from the Primary sort, Secondary sort,
Third sort, and Fourth sort drop-down lists. These drop-down lists include REF (reference
status), SEC (section code), SUBSEC (sub-section), and FILEPATHANDNAME (file path and
name) options.

Some projects do not contain subfolder(s). If you right-click on such a project and choose the
Sort option from the shortcut menu displayed; the Sort dialog box will be displayed, refer to
Figure 2-17.

Sort X

Primary sort Secondary sort Third sort Fourth sort

REF ~ SEC ~  SUBSEC ~  FILEPATHANDNAME ~

Cancel

Figure 2-17 The Sort dialog box
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After setting the required parameters, choose the OK button from the Sort dialog box; the dialog
box is closed and the drawing displayed in the list will be arranged according to the options
selected from the drop-down lists.

Removing a Drawing from a Project
You can remove a drawing from a project using two methods. These methods are discussed next.

First Method

Right-click on the drawing name in the PROJECT MANAGER; a shortcut menu will be
displayed. Choose the Remove option from the shortcut menu; the PROJECT MANAGER
- Remove Files message box will be displayed. Choose the Yes button from the message
box; the drawing will be removed from the project, but it will not be deleted from the folder
where it is stored.

Second Method

Right-click on a project name; a shortcut menu will be displayed. Next, choose the Remove
Drawings option from the shortcut menu; the Select Drawings to Process dialog box will
be displayed, as shown in Figure 2-18. The options in this dialog box are discussed next.

Select Drawings to Process X
(@ Drawing () Description
Ref Subfolder Section  Sub-Section Project Drawing List ~
SCHEMATIC C\Users\CADCIM\Documents,..ata\Proj\Nfpa
SCHEMATIC C:\Users) CADCIM\Documents),..ata\Proj\Nfpa
SCHEMATIC C\Users\CADCIM\Documents...ata\Proj\Nfpa
SCHEMATIC C\Users\capcim\Documents'_ata\Proj\Nfpa
SCHEMATIC C:\Users)CADCIM\Documents\...ata\Proj\Nfpa
SCHEMATIC C\Users\CADCIM \Documents)...ata\Proj\Nfpa..
SCHEMATIC C:\Users\CADCIM \Documents\..ata\ProjiNfpa... ¥
< >
Do All | 4} Process by Section/sub-section by Subfolder
Ref Subfolder Section  Sub-Section Project Drawing List
< >
Selectfrom the top list,
insertinto the bottom list 21 Eanc! " Miew

Figure 2-18 The Select Drawings to Process dialog box

Drawing: The Drawing radio button is used to display the path and the name of all drawings
in a project. This radio button is selected by default.

Description: Select the Description radio button; the description of all drawings will be
displayed in the top list of the Select Drawings to Process dialog box. Remember that the
description will be displayed only if you have entered the description in the Description
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1/2/3 edit boxes in the Create New Drawing dialog box or in the Description 1/2/3 edit
boxes of the Drawing Settings tab in the Drawing Properties dialog box.

Do All: Choose the Do All button to transfer all drawings from the top list to the bottom
list of the Select Drawings to Process dialog box.

Process: The Process button will be activated only if you select a drawing(s) from the top
list. This button is used to transfer the selected drawing from the top list to the bottom list.
To do so, select a drawing(s) and then choose the Process button; the selected drawing(s)
will be transferred from the top list to the bottom list of the Select Drawings to Process
dialog box. You can use the SHIFT or CTRL key to select more than one drawing at a time.

Reset: The Reset button will be activated only if you have transferred drawing(s) from the
top list to the bottom list. Choose the Reset button to reset the drawings to their original
positions in the dialog box.

Un-select: The Un-select button will be activated only if you select drawing(s) from the
bottom list. The Un-select button is used to transfer drawing from the bottom list to the
top list. To do so, select a drawing(s) from the bottom list and then choose the Un-select
button; the drawings will be moved from the bottom list to the top list. You can unselect
multiple drawings at a time by using the SHIFT or CTRL key.

by Section/sub-section: The by Section/sub-section button is used to select the drawings
that have been grouped by specifying their sections and sub-sections. To do so, choose
the by Section/sub-section button from the Select Drawings to Process dialog box; the
Select Drawings by Section/sub-section dialog box will be displayed. Specify the section
and sub-section codes in the Section and Sub-section edit boxes, respectively. Alternatively,
select the section and sub-section codes from the Section and Sub-section drop-down lists,
respectively. Next, choose the OK button from the Select Drawings by Section/sub-section
dialog box; the corresponding drawing(s) will be transferred from the top list to the bottom
list. Note that the Section and Sub-section drop-down lists display the section and sub-section
codes only if you have entered the section and sub-section values in the Sheet Values area
of the Create New Drawing dialog box or in the Drawing Settings tab of the Drawing
Properties dialog box.

by Subfolder: The by Subfolder button is used to select the drawings that have been
grouped in subfolders. To do so, choose the by Subfolder button from the Select Drawings
to Process dialog box; the Select Drawings by Subfolder dialog box will be displayed. Select
the subfolder(s) from this dialog box and choose the OK button; the drawings from the
selected subfolder(s) will be transferred from the top list to the bottom list. Note that the
Select Drawings by Subfolder dialog box displays the subfolders only if you have added
subfolders in the project.

After selecting drawings from the Select Drawings to Process dialog box, choose the OK button;
the Remove Drawing(s) from Project List message box will be displayed. In this message box,
choose the OK button; the selected drawings will be removed from the project list. Note
that the drawings will instantly be removed from the project list, but they will not be deleted
permanently from the folder where they are stored.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Assigning a Description to a Drawing

You can assign a three-line description to each drawing listed in your project. To do so, right-click
on the name of a drawing in the project; a shortcut menu will be displayed. Next, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog box
will be displayed.

By default, the Drawing Settings tab is chosen in the Drawing Properties dialog box. Enter
a description for the drawing in the Description 1/2/3 edit boxes. You can also select the
predefined description for your drawing from the Description drop-down list, refer to Figure 2-19.
Note that the predefined description will be available only if you have entered the description
for any of the drawings of a project. This figure shows the predefined descriptions listed in
the Description 1 drop-down list of the Drawing Properties dialog box. Next, choose the OK
button; the drawing file will be updated and the changes will be saved.

Drawing C\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemo\demol02.dwg

Drawing File

Project NFPADEMO

Description 1 3-phase motor control, Control circui Pick=>
3-phase motor control, Control circuit

Description 2: Control schematic Pick>>
Flow and Interconnection diagram. I/ list

Description 3: Main Control Panel layout Pick>>

Operator Station layout

[JFor Reference|PLC I/Q - Input Slot 5, Output Slot 6
PLC1/Q - Inputs - Slot 1

IEC - Style Designal PLC /O - Inputs - Slots 3, 4

Power supplies. [/O module feeds

Figure 2-19 Partial view of the Drawing Properties dialog box
displaying predefined description

/ Note

@ The description specified in the Description 1, Description 2, and Description 3 edit boxes of
the Create New Drawing or Drawing Properties dialog box can be linked to the attribute in
the title block for automatic update and will be discussed in the later chapters.

After adding description to a drawing, you can preview the description in the Details rollout of
the PROJECT MANAGER. These drawing details give a unique identity to the drawings based
on users requirement and helps users to search a particular drawing among multiple drawings
in a project file.

Switching between the Drawings of an Active Project

Ribbon: Project > Other Tools > Previous DWG
Project > Other Tools > Next DWG
Toolbar: ACE:Main Electrical 2 > Previous Project Drawing

ACE:Main Electrical 2 > Next Project Drawing

ACE:Quick Pick > Previous Project Drawing

ACE:Quick Pick > Next Project Drawing
Command: AEPREV and AENEXT

<3:| |I:[} | The Previous DWG and Next DWG tools are used to open the previous and next

drawings of an active project. Using these tools, you can view and switch between
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various drawings of a project. To do so, open any drawing of the active project and then choose
the Previous DWG or Next DWG tool from the Other Tools panel of the Project tab.
Alternatively, you can choose the Previous Project Drawing or Next Project Drawing tool from
the ACE:Main Electrical 2 or the ACE:Quick Pick toolbar. On doing so, the currently opened
drawing will be closed and all changes made to it will be saved. Also, the requested drawing will
open. The currently opened drawing will appear in bold text in the project list.

Tip

Q 1o open all drawings of an active project in a new window without closing the original
drawing window, hold the SHIFT key while choosing the Previous Project Drawing or
the Next Project Drawing button.

/ Note
@ 1. You cannot view and switch among the drawings that are not associated with the active project.
2. You can use the PROJECT MANAGER to preview the drawings easily using the Preview button.
3. If you move among various drawings using the up and down arrow keys, the selected drawing
will not open.

Configuring the Drawing List Display
B The Drawing List Display Configuration button is used to configure the information
related to various drawings in the Projects rollout of the PROJECT MANAGER. This
button is used to display the required information such as drawing number, description,
and so on. By default, only the name of the drawing is displayed in the Projects rollout of the
PROJECT MANAGER, as shown in Figure 2-20. Choose the Drawing List Display Configuration
button from the PROJECT MANAGER; the Drawing List Display Configuration dialog box
will be displayed, as shown in Figure 2-21. The options in this dialog box are discussed next.

Display Options Area
The Display Options area displays the predefined values that can be associated to a drawing.
x

Current Display Order W GEECEDER®-

The Current Display Order area lists the order in which §l ['\FPADEMO M

the required display options will be displayed in the e _d

Projects rollout in the PROJECT MANAGER. The File -y

Name option is displayed by default in this area. You % demo02.dwg

can add other display options in this area by selecting darieiBaing z

them from the Display Options area and then choose Z:EZE‘;ZEQ =

-awg 5]

>> button. -t demo06.dwg §

R demo07.dwg 5
I pANEL
> > []---EE EXTRA LIBRARY DEMO
The >> button is used to move only the selected LR GBDEMO 2

display option from the Display Options area to the

Current Display Order area. Figure 2-20 Partial view of the

PROJECT MANAGER displaying the
drawing files of the project
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Drawing List Display Configuration X
Display Options: Current Display Order:
Installation Code (%l) 5 File Name
Location Code (%L) Drawing Number (%D)

Section Alls> Drawing Description 1

Sub Section

Sheet Number (%5)
Drawing Description 2
Drawing Description 3

<<

<< All

l:l Separator Value Move Up

(@) Always show selection highlight

Move Down
(_) Show selection highlight only when active

Figure 2-21 The Drawing List Display Configuration dialog box

All>>
The All>> button is used to move all display options from the Display Options area to the
Current Display Order area.

<<
The << button is used to move only the selected display option from the Current Display
Order area to the Display Options area.

<<All
The <<All button is used to move all display options from the Current Display Order area to
the Display Options area.

Separator Value

The Separator Value edit box is used to specify the character to be used as a separator between the
values in the listing. You can enter a character in the Separator Value edit box or use the default
character (-) in this edit box.

Move Up
Choose the Move Up button to move the selected display
option one step up in the Current Display Order area.

x
w (2B I REL
#  NFPADEMO .

Projects

Projects -
M D &£ ] scHEMATIC ~
ove own 'S demo01.dwg
Choose the Move Down button to move the selected . 5 demo02.dwg
. . . . H m
display option one step down in the Current Display | demol3.dwg z
Order area || demoDsdwg =
: B demo05.dwg 5
H 'S demo06.dwg E
© LM g
Choose the OK button in the Drawing List Display | i demo07.dwg v

Configuration dialog box; the entire information
related to drawings will be displayed in the Projects
rollout, refer to Figure 2-22.

Figure 2-22 Partial view of the
PROJECT MANAGER displaying the
drawing information
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Note
@ The drawing options are displayed in the Current Display Order area in a particular sequence.
~ The same sequence is followed for their display in the Projects rollout of the PROJECT
MANAGER. If you want to change the sequence, choose the Move Up or Move Down button.

Copying a Project )
Ribbon: Project > Project Tools > Copy
Toolbar: ACE:Main Electrical 2 > Project Manager drop-down > Copy Project
or ACE:Project > Copy Project
Menu: Projects > Project > Copy Project

Command: AECOPYPROJECT

1  The Copy tool is used to copy the entire project as well as copy the drawings present
0 within that project. In AutoCAD Electrical 2023, you can copy the project in a single
step. To copy the project, choose the Copy tool from the Project Tools panel of the
Project tab; the Copy Project: Select Existing Project to Copy dialog box will be displayed, as
shown in Figure 2-23.

ﬂ Copy Project: Select Existing Project to Copy *

Use Active Project |

Enter existing project path
C\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemao\NFPAdemo.wdp |I|

Use selected project as template project

New project name

NFPAdemo - copy.wdp

New project location
C\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemo - copy III

Note: If one or more drawings are open in the project that's to be copied to a new project, these drawings will be saved.

‘ oK | | Cancel | | Help

Figure 2-23 The Copy Project: Select Existing Project to Copy dialog box

Next, enter the name and path of the existing project in the Enter existing project path edit
box. Alternatively, choose the Browse button next to this edit box to select the existing project;
the Open dialog box will be displayed. Next, navigate to the project folder and double-click on
it. Next, select the project’s .wdp file and choose the Open button; the name and path of the
existing project will be displayed in the Enter existing project path edit box. You can also choose
the Use Active Project button available in this dialog box to copy the currently active project.

Enter a name for the new project in the New project name edit box. Next, enter the location
where the new project will be saved in the New project location edit box. Alternatively, choose
the Browse button next to this edit box to specify the location. Also, make sure the Use selected
project as template project check box is selected and then choose the OK button; you will notice

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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that the project will be copied and the name of the copied project will be displayed at the top
in the Projects rollout in bold text. This will now become the active project.

You can also customize the project to be copied. To do so, you need to clear the Use selected
project as template project check box, refer to Figure 2-24. Next, enter the information in this
dialog box as discussed above and then choose the OK button; the Select Drawings to Process
dialog box will be displayed, as shown in Figure 2-25.

ﬂ Copy Project: Select Existing Project to Copy X

L . Use Active Project
Enter existing project path

C\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\NFPAdemo\NFPAdemo.wdp E
[] Use selected project as template project

New project name

NFPAdema - copy.wdp

New project location
C\Users\CADCIMT\Dacuments\AcadE 2023\AeData\proj\NFPAdemo - copy Ij

Note: If one or more drawings are open in the project that's to be copied to a new project, these drawings will be saved.

‘ 0K || Cancel H Help ‘

Figure 2-24 The Use selected project as template project check box cleared

Select Drawings to Process XK
(@) Drawing () Description
Ref Subfolder Section  Sub-Section Project Drawing List ~
SCHEMATIC C\Users\CADCIM\Documents..ata\Proj\Nfpa
SCHEMATIC C\Users\CADCIM\Documents\,.. ata\Proj\Nfpa
SCHEMATIC C:\Users\CADCIM \Documents),..ata\Proj\Nfpa...
SCHEMATIC C\Users\cADCIM \Documentsl...ata\Proj\Nfpa...
SCHEMATIC C:\Users)| CADCIM\Documents),..ata\Proj\Nfpa...
SCHEMATIC C\Users\CADCIM \Documents\...ata\Proj\Nfpa
SCHEMATIC C\Users\CADCIM \Documents\,.ata\Proj\Nfpa... ¥
< >
Do All ﬂr Process f Reser f Un=sefect by Section/sub-section by Subfolder
Ref Subfolder Section Sub-Section Project Drawing List
£ >
Selectfrom the top list,
insertinto the bottom list K ancal Liolp =D

Figure 2-25 The Select Drawings to Process dialog box
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Select the drawing files that you want to copy in the project from the top list of this dialog box.
Next, choose the Process button; the selected drawings will be transferred from the top list of
the Select Drawings to Process dialog box to the bottom list. The other options in the Select
Drawings to Process dialog box have already been discussed. Choose the OK button from the
Select Drawings to Process dialog box; the Copy Project: Enter Base Path for Project Drawings
dialog box will be displayed, refer to Figure 2-26.

< Note

@ In case, there is no drawing file in the project to be copied, then the Select Drawings to Process
dialog box will not be displayed and the AutoCAD Message message box will be displayed. Choose
the OK button in this message box; the Copy Project: Enter Base Path for Project Drawings
dialog box will be displayed.

Copy Project: Enter Base Path for Project Drawings X

‘C \Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemo - copy!,

Browse

The base path above will be substituted for this path in the existing project
clusers\cadciml\documents\acade 2023\aedata\proj\nfpademo\

Copies ofthe drawings will be copied to this new path.
Ifthe directory path does not exist, it will be created

SelectProject-Related Files to be Copied

[ Title Block Setup (wdt) Location Codes (loc)
Project Line Labels (.wdl) Installation Codes (.inst}
Component Description Defaults (wdd) Ratings Defaults (wdr)
Catalog Lookup Database (catmdb) Component Tagging (wdx)
Footprint Laokup Database (lookup.mdb) Spreadsheet PLC /O Utility Settings ( wdi)
Family Code Mapping (wd_fam.dat) RSLogix Import Mapping (wdf)
Wire Color/Gauge Label (wdw) User Defined Attributes (wda)
Schematic Lookup Database (schematic_lookup.mdb) Terminal Audit Filter (.wdn)
Cancel

Figure 2-26 The Copy Project: Enter Base Path for Project Drawings dialog box

In this dialog box, you can specify the project related files that need to be copied to the project.
Note that the project related files to be copied will be activated in the Select Project-Related
Files to be Copied area. You need to select the respective check boxes and then choose the
OK button; the Copy Project: Adjust new drawing file names dialog box will be displayed, as
shown in Figure 2-27.

Copy Project: Adjust new drawing file names X

C:fUsers/CADCIM1/D dE 2023/AeData/proj/NFPAdemo - copy/demal2.dwg

C:fUsers/CADCIM1/Documents/AcadE 2023/AeData/proj/NFPAdemo - copy/demal3.dwg

C:fUsers/CADCIM1/D dE 2023/AeDat: NFPAdemo - copy/demo04.dwg

C:/Users/CADCIM1/Documents/AcadE 2023/AeData/proj/NFPAdemo - copy/dema05.dwg

C:fUsers/CADCIM1/D AcadE 2023/AeDat: NFPAdemo - copy/dem dwg

C//Users/CADCIM1/D dE 2023/AeData/proj/NFPAdemo - copy/dema(7.dwg

C:fUsers/CADCIM1/D AcadE 2023/AeData/proj/NFPAdemo - copy dwg

C;/Users/CADCIM1/D dE 2023/AeData/proj/NFPAdemo - copy/demo(9.dwg

< >
Edit Find/Replace

Figure 2-27 The Copy Project: Adjust new drawing file names dialog box
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Choose the Edit button in this dialog box to edit the file name and path of the selected drawing,
if needed. Similarly, choose the Find/Replace button to find or replace a drawing file name and
its path. Next, choose the OK button; the name of the new project will be displayed at the top

in the Projects rollout in bold text and it will become the active project.

Deleting a Project

Ribbon: Project > Project Tools> Delete
Menu: Projects > Project > Delete Project
Command: AEDELETEPROJECT

The Delete tool or the AEDELETEPROJECT command is used to delete an

p 4

existing project and its drawings permanently. To do so, choose the Delete tool from

the Project Tools panel of the Project tab; the Select Existing Project to Delete dialog box will

be displayed, as shown in Figure 2-28.

ﬂ Select Existing Project to Delete X
Look in: | Proj V‘ (€] : E~ Ca E*]
Name - Date 1 ™

Aegs 3/30/.
Demo 3/30/.
Extra Library Demo 3/30/.
GbDemo 3/30/.
lec60617Demo 3/30/4.
lecDemo 3/30/.
lamaMams -~ EX=laVs N7

< >
File name \/| | Open |
Files of type: *wdp w Cancel

Locate Find File...

Figure 2-28 The Select Existing Project to Delete dialog box

Enter the name of the project file to be
deleted in the File name edit box.
Alternatively, select a project name from
the list displayed in the Select Existing
Project to Delete dialog box. Next,
double-click on the name of the project
folder, if it exists. Select the project
definition file(.wdp) and choose the
Open button; the Project File Delete
Utility dialog box will be displayed, as
shown in Figure 2-29. The options in
this dialog box are discussed next.

Project File Delete Utility X

Caution
This utility Deletes files
There is no "Unda"
ltis permanent!

[] Delete "wdp" projectlistfile
c\users| CADCIM\documents), _ta\proj\demo\wddemo wdp

|:| Delete project's AutoCAD drawing files

List Selectfrom project's drawing file list

Delete Files Cancel

Figure 2-29 The Project File Delete Utility dialog box
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Delete “.wdp” project list file
The Delete “.wdp” project list file check box is used to permanently delete the selected project
file with .wdp extension.

Delete project’s AutoCAD drawing files

The Delete project’s AutoCAD drawing files check box is used to delete only the drawing
files of a project. Note that this check box will be activated only if the related project consists
of drawing files.

List

The List button will be activated only if you select the Delete project’s AutoCAD drawing files
check box. Choose the List button; the Select Drawings to Process dialog box will be displayed,
refer to Figure 2-25. Select the drawings to be deleted from the drawing file list of the project.
Next, choose the OK button from the Select Drawings to Process dialog box; the Project File
Delete Utility dialog box will be displayed again. Choose the Delete Files button from the
Project File Delete Utility dialog box; the selected files will be deleted permanently, and you
cannot retrieve them.

Other Options in the PROJECT MANAGER

As discussed earlier, the PROJECT MANAGER lists the drawing files associated with each
project. You can change the settings of a project by using the PROJECT MANAGER, refer
to Figure 2-30. The major tools and rollouts in the PROJECT MANAGER have already been
discussed. The remaining ones are discussed next.

Buttons

Project selection drop-down list
Projects rollout

Project Drawing list
Details/Preview rollout

G 00 N0 —

Buttons
There are several buttons available in the PROJECT MANAGER such as Refresh, Publish/
Plot, and so on, see Figure 2-31. These buttons are discussed next.

Refresh

The Refresh button is used to freshen the drawing list present in the
" PROJECT MANAGER.

Project task List

The Project Task List button will be activated only if there are pending updates for
a drawing file. The Project Task List button is used to execute the pending updates
on any drawing file modified in the active project. Choose the Project Task List
button from the PROJECT MANAGER or right-click on the active project; a shortcut menu
will be displayed. Next, choose the Task List option from the shortcut menu; the Task List
dialog box will be displayed. Select the drawing files that you want to update and choose
the OK button; the QSAVE message box will be displayed. Choose the OK button from the
QSAVE message box; the drawing(s) will be updated. The process of keeping the updates

*
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pending at a certain stage in the drawing and executing these updates later using the Task
List option as well as options in the Task List dialog box are discussed in detail in Chapter 12.

W BREECEBRE-
#  NFPADEMO -
Projects -
=-C[5 NFPADEMO
i 2] SCHEMATIC

S demo01 dwg

-Buttons

-Project selection drop-down list

Projects

Project Drawing List

Location View

Details EN

Status: Accessible 2
File Name: NFPAdemo.wdp

Location: C\Users\CADCIM1
\Documents\AcadE 2023\AeData

\proj\NFPAdemo Details/Preview rollout

Project Database: C:\Users
\CADCIM1\AppData\Roaming
\Autodesk\AutoCAD Electrical
2023\R24.2\enu\Support\user
\NFPADEMO.mdb

Title 1: Sample Project -
Schematics and Panel Layout

B3 PROJECT MANAGER

Figure 2-30 larious components of the PROJECT MANAGER

Project Task List

Project-Wide Update/Retag
Refresh _ Drawing List Display Configuration
Mew Drawing Publish/Plat
Mew Proiect Help
Open Project —‘—‘ r
I

AECHBR® O

Figure 2-31 Various buttons in the PROJECT MANAGER

Project-Wide Update/Retag
] The Project-Wide Update/Retag button is used to update the related line
R reference numbers, device tagging, cross-reference text, and signal reference
updates on the selected drawing files in an active project. Choose the Project-Wide
Update/Retag button from the PROJECT MANAGER; the Project-Wide Update or Retag
dialog box will be displayed. Specify the required options in this dialog box and choose the
OK button; the Select Drawings to Process dialog box will be displayed. Now, select the
drawings that you want to process and choose the Process button. Next, choose the OK
button; the selected drawings will be updated. The options in the Project-Wide Update or
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Retag dialog box will be discussed in detail in Chapter 6. You can also use the (WD_BUMP)
command to invoke the Project-Wide Update or Retag dialog box.

Publish / Plot

=1 Choose the Publish/Plotbutton from the Project
Manager; the Publish/Plot drop-down will be
displayed, as shown in Figure 2-32. The options

in the drop-down of the Publish / Plot button are used

to plot active drawings, publish the drawings of the

active project to web, DWE, PDF, DWFx and zip the

active project. Choose the Plot Project option from the

BOECERBR-O

NFPADEMO Plot
Projects Publ
CA NFPADEMO zP

Project
lish to PDF/DWF/DWFx

Project

Figure 2-32 The drop-down displayed
on choosing the Publish / Plot button

drop-down to batch plot one or more drawings in the active project. The Plotting of

drawings will be discussed in detail in Chapter 12.

Help

When you choose the Help button from the PROJECT MANAGER, the AutoCAD

@ Electrical 2023 - Help window will be displayed. Alternatively, choose Help from
the Help menu to display the AutoCAD Electrical 2023 - Help window. This
window helps you understand different options, commands, and tools of AutoCAD Electrical.

Note
@ If you press F1 or use the HELP command, it will also display the AutoCAD Electrical 2023

- Help window.

Project selection Drop-down List

The Project selection drop-down list is available at the
top of the PROJECT MANAGER, as shown in
Figure 2-33, and it consists of names of all open projects
and following options:

1. Recent
2. New Project
3. Open Project

You cannot close any open project using the Project
selection drop-down list. The other options in this
drop-down list are discussed next.

Recent

When you select the Recent option from the Project
selection drop-down list, the Recent Projects dialog
box will be displayed. In this dialog box, you can
view the recently opened projects, view the drawings

BEER&C

NFPADEMO
WDDEMO
NFPADEMO

EXTRA LIBRARY DEMO
JISDEMO

GBDEMO

IECDEMO
POINTZPOINT
IECE606T7DEMO
IEEEDEMO

Recent...

Mew Project...
Open Project...

-

Figure 2-33 Th

¢ PROJECT

MANAGER displaying the Project
selection drop-down list

of the selected project, remove the selected project, and find the drawings from the recent
projects list displayed in the Recent Projects dialog box.
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New Project

The New Project option is used to create a new project. To do so, select the New Project
option from the Project selection drop-down list; the Create New Project dialog box will
be displayed. The options in this dialog box have already been discussed. Specity the
required options and choose the OK button; the new project will be created and will appear
in bold text on the top of the list in the Projects rollout. Also, the newly created project will
automatically become an active project.

Open Project

The Open Project option is used to open an existing project. To do so, select the Open
Project option from the Project selection drop-down list; the Select Project File dialog box
will be displayed. Next, select the required project from this dialog box and choose the Open
button; the selected project’s name will automatically be displayed in the Projects rollout
in bold text and the project will become an active project.

Projects Rollout

The Projects rollout displays a list of all opened
projects. You can open as many projects as you want,
but only one project can be active at a time. The
active project appears in bold text and is always
displayed at the top of the list in the Projects rollout.
When you right-click on the name of the active
project or on the project that is in bold text, a shortcut
menu will be displayed, as shown in Figure 2-34. The
options in the shortcut menu are discussed next.

Close
The Close option is used to remove the project
which is displayed in the Projects rollout.

Expand All
The Expand All option is used to expand a
project and subfolder(s) in a project, if any.

Collapse All
The Collapse All option is used to collapse a
project and subfolder(s) in a project, if any.

Add Subfolder
The Add Subfolder option is used to add a
subfolder to a project.

Flatten Structure

The Flatten Structure option is used to remove subfolder(s) from the project to get a flat

drawing list in a project.

x
W EOE S
#| @ NFPADEMO
Projects
B rraoe
-3 EXTRA LIB|
#3 GBDEMO
PR, IEC60617D
PR, IECDEMO
& £ IEEEDEMO
w7 nspemo
@£ poinT2PO

Details

Status: Accessible
File Name: NFPAd

Location: C\Users
\Documents\Acac
\proj\NFPAdemo

Project Database:
\CADCIMA\AppD;
VAutodesk\AutoC
2023\R24.2\enu\S
\NFPADEMO.mdE

Title 1: Sample Pri
Schematics and Py

Projects

Close

Expand All
Collapse Al

Add Subfolder
Flatten Structure

Descriptions...
Title Block Update...
Drawing List Report...

Flip DWG Name to Lower Case
Flip DWG Name to Upper Case
Sort...

New Drawing...
Add Drawings...
Add Active Drawing
Remove Drawings...
Task List...

Publish

Settings...
Exception List...
Properties...

B PROJECT MANAGER

Figure 2-34 The shortcut menu displayed
by right-clicking on the active project in the

v

PROJECT MANAGER
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Descriptions

The Descriptions option is used to edit the description of an existing project. It is also used
to add description to a new project. To do so, choose the Descriptions option from the
shortcut menu; the Project Description dialog box will be displayed, refer to Figure 2-10.

As the Project Description dialog box displays unlimited lines, you can enter the description
as per your requirement. The information that you enter in these lines can be re-used in
the Component, Bill of Material, and Wire reports that are generated for the project or
mapped to title block of the drawing. Select the in reports check box from the Project
Description dialog box to include the project description line information in report headers
and title blocks, which will be discussed in detail in the later chapters.

Title Block Update

The Title Block Update option is used to update the information of the title block for the
entire project drawing set or for the active drawing. To update the title block information,
right-click on the active project; a shortcut menu is displayed. Choose the Title Block Update
option from the shortcut menu; the Update Title Block dialog box will be displayed, as
shown in Figure 2-35. The options in this dialog box will be discussed in detail in Chapter 12.
You can also update a title block by using the WD_TB command.

Update Title Block X
Seleet Line(s) to Update (Project Description Lines)
[l Title 1: Sample Project - Schematics and [ | LINE13 (blank)
O Title 2: (blank) O LINE14 (blank)
O Title 3 (blank) O LINE15 (blank)
O Job Number (blank) O LINET6 (blank)
O Date (blank) O LINE17 (blank)
O Engineer. (blank) O LINE18 (blank)
O Drawn By: (blank) O LINE19 (blank)
O Checked By: (blank) O LINE20 (blank)
[l Scale (blank) [l LINE21 (blank)
[l LINE10 (blank) [l LINE22 (blank)
[l LINET1 (blank) [l LINE23 (blank)
O LINE12 (blank) O LINE24 (blank)
Select Al Clear All < < > 5 Save
Select line(s) to update (these are per-drawing values)
1 Drawing Description: [ ]1 Oz [s3 Op O [OL(%P.%L%L values)
[l  Drawing Section (blank) [0 Drawing (%D value)
0 Drawing Sub-section. ~(blank) [  sheet(%Svalue) [ ]  Previous(%Svalue) [ |  Next(%S value)
O Filename: DEMQO2 Upper case O Sheet maximum l:l
[0 Filejextension DEMO02 dwg
] FullFilename C4Users\. FPAdemo\DEMO02 DWG L Resequence sheet %S values
Activate each drawing to process
OK Active Drawing Only OK Project-wide Cancel Help Wide>

Figure 2-35 The Update Title Block dialog box

Drawing List Report

The Drawing List Report option is used to generate a report that lists the project drawing
information of title block such as file names, file date, time, sheet number, drawing
descriptions, sections, and so on. To generate a report, choose the Drawing List Report
option from the shortcut menu or use the WD_DWGLST_PRO]J command; the Drawing
List Report dialog box will be displayed. The options in this dialog box are used to extract
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the new drawing list report, display previous drawing list report, and select format file for
report. You will learn more about the generation of reports in Chapter 9.

Task List

The Task List option will be activated only if an active project has pending updates on any
drawing file which is present within the active project and has been modified. Choose the
Task List option from the shortcut menu; the Task List dialog box will be displayed. The
options in the Task List dialog box will be discussed in Chapter 12.

Publish

When you right-click on an active project and move the cursor to the Publish option of the
shortcut menu, a cascading menu will be displayed, as shown in Figure 2-36. This cascading
menu consists of various options such as Plot Project, Publish To PDF/DWF/DWFx, and Zip
Project. Choose the Plot Project option to plot one or more drawings in the active project.
The Publish To PDF/DWF/DWFx, and Zip Project options are used to publish the project
to pdf, dwf, dwfx and to create the zipped file of a project, respectively.

w BEERCE B
£ | |BNFPADEMO - 7
{1
Projects - =
a
PR nrPADEw)
E_D EXTR Close
FAGBDE  Expand All
IR 1Ecsc Collapse Al
PR Ieco Add Subfolder
E_D |EEEC Flatten Structure
E:D JISDE Descriptions...
OPOIN  Title Block Update...
Details Drawing List Report..
Status: Acce: Flip DWG Name to Lower Case
File Name: M Flip DWG Name to Upper Case
Sort...
Location: C:\ .
\Documents New Drawing..
\proj\NFPAc Add Drawings...
i Add Active Drawing
Project Data Remove Drawings...
\CADCIM1\/
o VAutodesk\2 Task List...
9 2023\R24.2\, - .
>
:z: \NFPADEMC Publish Plot -P[OJECI
= Settings.. Publish to PDF/DWF/DWFx
G Title 1: Samg Exception List... ZIP Project
4| | Schematics ¢ .
g Properties... [
&
o
v

Figure 2-36 Cascading menu displayed on
selecting the Publish option

Settings

When you choose the Settings option from the shortcut menu, the Current Settings dialog
box is displayed. This dialog box displays settings of a project and information about
AutoCAD Electrical environment.
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Exception List

When you choose the Exception List option from the shortcut menu, the Properties
Exception List dialog box is displayed, as shown in Figure 2-37. This dialog box displays the
list of drawing files that possess the properties different from the project definition file
(*.WDP). Figure 2-38 shows the Properties Exception List dialog box that will be displayed if
the settings of all drawing files of a project match with the settings of the project definition
file. Also, this dialog box displays that there are no exceptions.

Properties Exception List: NFPADEMO x

These drawing(s) have different properties than the project defaults. Use the Settings Compare

!E\ function to display differences.

File Name: demo01.dwg ~
Status: Accessible
Location: C:\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdema

File Name: demo02.dwg
Status: Accessible
Location: C:\Users\CADCIMT\Documents\AcadE 2023\AeData\projiINFPAdemo

File Name: demo03.dwg
Status: Accessible
Location: C:\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\NFPAdemo

File Name: demo04.dwg
Status: Accessible
Location: C:\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\NFPAdemo

File Name: demo05.dwg v

Figure 2-37 The Properties Exception List dialog box

Properties Exception List: POINT2POINT X

@ All drawings match the project defaults.
f )

Figure 2-38 The Properties Exception List dialog box
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> Note

@ You can view the difference between drawing properties and project defaults. 1o do so, choose

Settings Compare from the Projects menu or choose the Settings Compare button from the
Drawing Properties drop-down in the ACE:Main Electrical 2 toolbar; the Compare Drawing
and Project Settings dialog box will be displayed. This dialog box is used to compare the drawing
and project default settings.

Properties

On choosing the Properties option from the shortcut menu, the Project Properties
dialog box will be displayed, as shown in Figure 2-39. You can use this dialog box to edit
and modify the properties for project settings, components, wire numbers, cross-references,

styles, and drawing format. The editing of project properties will be discussed in detail in
Chapter 12.

Project Properties X

Project Setings Components Wire Mumbers Cross-References Styles Drawing Format
Project  C:\Users\CADCIMT\Documents\AcadE 2023\AeData\proj\NFPAdemo\NFPAdemo.wdp
E_D Library and lcon Menu Paths

- D Schematic lcon Menu File
) Browse...
B Panel Footprint Libraries
; D Panel lcon Menu File Remove
Move Up
Move Down
Default
E_D Catalog Lookup File Preference
® Use component specific tables OtherFile.. | (none defined)
(O) Always use MISC_CAT table
O Use MISC_CAT table only if component specific table does not exist
E_D Options
Tag (Wire Number [ Wire Sequence Sort Order
Real time error checkin Mo Project Default ~
g ]
Electrical Code Standard:
|Defau|t (National Electrical Code) w

Cancel Help
Figure 2-39 The Project Properties dialog box
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will be displayed, as shown in Figure 2-40. If you choose this option from the shortcut menu, the
selected project will become active and will be displayed at the top of the projects list in bold text.

Project Drawing List

The Project Drawing list displays the drawings available in a project. If you double-click on a
project name in the Projects rollout of the PROJECT MANAGER, the drawings associated with
that project will be displayed. Right-click on a drawing file name; the editing options will be
displayed, as shown in Figure 2-41. Using these options, you can open, close, remove, rename,
and replace a drawing file. You can also edit the properties of a drawing by choosing Drawing
Properties from the shortcut menu, refer to Figure 2-41. The options in this shortcut menu are
discussed next.

~—~ Note

@ You can convert a drawing file into a reference drawing. 1o do so, right-click on the drawing

"~ name and choose Properties > Drawing Properties from the shortcut menu; the Drawing
Properties dialog box will be displayed. Select the For Reference Only check box from the
Drawing Settings tab; the drawing file will be converted into a reference drawing. However; its
extension (.dwg) will remain the same.

x
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Sheet:

Projects
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Open
Close

Copy To
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Replace...
Rename

Properties > Drawing Properties...

control, Apply Project Defaults

Description: 3-phase motor
Control circuit

File Name: demo02.dwg

location: C:\Users\CADCIM1

Copy
Paste

Settings Compare...

Figure 2-40 The shortcut menu displaying ~Figure 2-41 The editing options available
the Activate option in the shortcut menu

Open

On choosing the Open option from the shortcut menu, the selected drawing will open in a
new window and its name will appear in bold text in the Project Drawing list. Alternatively,
you can select a drawing file name and press ENTER to open the corresponding drawing.
You can also open a drawing file by double-clicking on it. The OPEN command is also used
to open a drawing file.

Close

Choose the Close option from the shortcut menu to close the current drawing file. This
option will be available only if the drawing file is open. You can also close a drawing file by
using the CLOSE command.
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Copy To

The Copy To option is used to copy the selected drawing to the same or another open
project. To do so, choose the Copy To option from the shortcut menu; the Copy To dialog
box will be displayed, as shown in Figure 2-42. Next, from the Save in drop-down list, select
the location where you want to copy the drawings. If you want to change the name of the
drawing file, enter the drawing file name in the File name edit box. Next, select the project
name from the Project drop-down list. Choose the Save button; the Apply Project Defaults
to Drawing Settings message box will be displayed. Choose the Yes button in the message
box to apply the project default values to the newly added drawing’s WD_M block definition;
the selected drawing(s) will be copied to the specified project. If you want the new drawing
to retain its existing settings, choose the No button.

Remove
Choose the Remove option from the shortcut menu to remove the selected drawing from

the current project. This option does not remove the drawings permanently.

n Copy To X

Save in- | NfpaDemao V| [ M5 =l | o

*

Quick access

DEMOO1 DEMO02 DEMO03

MNetwork

File name: |demo|}3 | Save
Save as type: DWG@G Files (".dwg) ~ Cancel
Project: NFPADEMO ™

Figure 2-42 The Copy To dialog box

Replace

The Replace option is used to replace the selected drawing with the desired one. To do
so, choose the Replace option from the shortcut menu; the Select Replacement Drawing
dialog box will be displayed, as shown in Figure 2-43. Next, select the drawing file and
choose the Select button; the Apply Project Defaults to Drawing Settings message box
will be displayed, refer to Figure 2-13. Choose the Yes button to apply the project default
values to the newly added drawing’s WD_M block definition. If you want the new drawing
to retain its existing settings, choose the No button; the drawing file will get replaced with
the selected drawings. This drawing will be displayed in the Project Drawing list. Also, note
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that if the drawing is already present in the project, it will display the message that drawing
is already present in the project.

Rename

The Rename option is used to rename the selected drawing. To do so, choose the Rename
option from the Project Drawing list; the name of the selected drawing will be replaced by
an edit box. Enter a new name in the edit box to rename the drawing.

Drawing Properties

The Drawing Properties option is used to change the drawing settings, component tag
format, wire number format, cross-reference format, styles, and drawing format. Also, you
can edit, assign, and remove the section and sub-section codes of a drawing. To do so, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog
box will be displayed. In the Drawing Properties dialog box, you can assign descriptions
to the drawing files. Note that each individual drawing can have its own drawing settings
for designing purpose.

ﬂ Select Replacement Drawing X
Look in: NipaDemo e 4 :+ Views w Tools
3 MName - Preview
\_a -
= B DEMODT
History B DEMOD2
B DEMOD3
£ B DEMO04
Documents SVDEMOUS
B DEMODS
- B DEMOO7
Deskiop E_DEMOUB
B DEMOO09
< >
File name: | " Select
Files oftype’ | Drawings (* dwg) - Cancel

Figure 2-43 The Select Replacement Drawing dialog box

Apply Project Defaults

Choose the Apply Project Defaults option from the shortcut menu to apply the project
default settings of the project to the new drawing files, if it was not done while creating the
drawing files.

Copy
You can copy drawing settings and options from one drawing to one or more drawings by
choosing the Copy option from the shortcut menu.
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Note

The drawing-specific information that is displayed in the Drawing Settings tab of the
Drawing Properties dialog box cannot be copied from one drawing to another; refer to Figure 2-12.

Paste

Choose the Paste option from the shortcut menu to apply the copied drawing settings as

well as other options from one drawing to other selected drawing(s).

Settings Compare

The Settings Compare option is used to compare the drawing with its project settings. To
do so, choose the Settings Compare option from the shortcut menu; the Compare Drawing
and Project Settings dialog box will be displayed, as shown in Figure 2-44. This dialog box
displays the difterences between the drawing settings and their associated default values in
the project definition file (wdp). See Figure 2-44, where demo0I.dwg is the drawing name

and NFPADEMO is the project name.

Compare Drawing and Project Settings: demo01.dwg Versus NFFADEMO
() Show All
@Show Differences Select All Match Project Match Drawing
Settings Description Drawing Project
Wire layers BLK* WHT* RED*,GRN* WIRES |WIRES
XREF_TBLFLDMAMS W1,T1,TYPE, T2 W2 REF,SH.S |W1,T1, TYPE.T2,W2 REF,SH.S

Figure 2-44 The Compare Drawing and Project Settings dialog box

Details/Preview Rollout

The Details/Preview rollout displays the details of the selected project or drawing as well as the
preview of the selected drawing. The Details and Preview rollouts shown in Figure 2-45 and

Figure 2-46 respectively are discussed next.
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Details Sl v
Status: Accessible 2
Sheet:

Preview =

Description: 3-phase motor
control, Control circuit

File Name: demo02.dwg
Location: C\Users\CADCIM1

\Documents\AcadE 2023\AeData
\proj\NFPAdemo

File Size: 147KB (150862 bytes)
Last Saved: 1/30/2017 3:50:24 PM
Last Edited By: Autodesk

Figure 2-45 The PROJECT MANAGER  Figure 2-46 The PROJECT MANAGER
displaying the Details rollout displaying the Preview rollout

Details
= The Details button is used to view details of the selected project and drawing. To do so,
select a project or drawing from the Projects rollout and then choose the Details button
from the Details/Preview rollout in the PROJECT MANAGER; details of the selected
project or drawing will be displayed in the Details rollout. Whenever you select a drawing file,
its details get updated and remain visible till you select a new drawing file. The information that
will be displayed in the Details rollout includes status, description if added, file name, file
location, file size, date when the file was last saved, the name of the user who modified the file
last, and so on, refer to Figure 2-45.

Note
You can switch/move from one drawing to another by using the wp and down arrow keys.

Preview
The Preview button is used to display preview of the selected drawing in the Preview
E rollout. To preview a selected drawing, select the drawing from the Projects rollout and
then choose the Preview button from the Details/Preview rollout; the image of the
selected drawing will be displayed in the Preview rollout, refer to Figure 2-46. The image of the
selected drawing will be visible till you select another drawing from the Projects rollout. You
can use up and down ARROW keys to view all drawings of a project.

Note

As discussed in the previous section, you can use the PROJECT MANAGER to preview drawings.
When you scroll through the drawings in the PROJECT MANAGER using the up and down
ARROW keys, the preview or the details of the drawing get displayed in the PROJECT MANAGER.

Location View TAB

The options in the Location View tab of the PROJECT MANAGER are used to display and filter
the components based on the installation and location codes, display details and connections
of the components, and so on. Figure 2-47 shows the PROJECT MANAGER with the Location
View tab chosen. The options in this tab are discussed next.
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Filter by Installation and Location
@ »| This button is used to filter components in the Component Tree as per the installation
and location codes. When you click on the down arrow of this button, a flyout is displayed,
refer to Figure 2-48. This flyout consists of various combinations of installation and
location codes available in the active project as options. You can click on any of these options
to view or hide components in the Component Tree based on the requirement.

Refresh Tree for Local Changes
#~| Thisbutton is used to refresh the Component Tree, the Details pane, and the Connections
s pane based on the changes made in the current session.

Search Field

This field is used to specify the search text such as component name, installation code, or
location code.

Go

This button is used to search the text entered in the Search field.

Search field Display Details and
Filter by Connections

Installation Refrach Tree for

and Location Local Charfgei Help
x a)
La 0
1 9' e =2
Go

#% Type here to search...

Projects

NFPAdemo.wdp
B NFPAdemo Component
=S Tree
an
B FLOOR ‘ PROJECT MANAGER
B O DISC207 z . — —
S eapny | 2 v 50@‘ |
< 07 Pin 2} <
{g(??) {Pin 3} % [ Select all
“% (77) {Pin 4} 3 =(77)+(77)
4, 07 Pin 5}
o -
& @7 Pin 6l =(77)+FLOCOR
- DISC211 =(77)+JBOXL
‘O DIsC215 =(77)+ MACHINE
g migfg =(77)+ MCABS
O MTR216 =(77}+OPSTA2
O PL207: [)]
O PL207 : [P]
% O PL211: 0]
< O PL211:[P]
= O PL215: 1]
= O PL215:[P]
2 JBOX1
g MACHINE
o MCABS
(4] OPSTA3 M M

Figure 2-47 The PROJECT MANAGER  Figure 2-48 Flyout displayed on choosing the
with the Location View tab chosen Filter by Installation and Location button
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Component Tree

The Component Tree displays a list of all the components available in the active project. It has
various nodes. The main node is the active project node. When you expand this node, a node
representing installation code will be displayed. When you expand this node, all location code
nodes will be listed as separate nodes. You need to expand these nodes to view the components
with these installation/location codes as separate nodes. This list also includes PLC modules,
connectors, cable markers, and terminals. You need to expand these component nodes in the
Component Tree to view pin information of the components, refer to Figure 2-49. When you
hover the cursor over a component, the detailed information about the component such as
catalog information, assembly code, description is displayed, refer to Figure 2-50.

You will notice that there are different icons on the left of each component. The significance of
these icons is explained in Table 2-1.

To expand or collapse all the nodes in the Component Tree, right-click on any of the installation
or location nodes and choose the respective option from the shortcut menu displayed, refer to
Figure 2-51.

B FLOOR
B © DISC207
B (27) {Pin 1)
& (27) {Pin 2)
% (77) {Pin 3} © PLCEOZ
& (77) {Pin 4} © PLCE22
& (27) {Pin 5} © PL{ Electrical Only Component Tag: PLC602
o (??) {Pin 6} © TB{ Manufacturer: AB
© DISC211 © TB{ Catalog Number: 1771-IAD
© DIsC215 © TB{ Assembly Code:
B O MTR208 © TB{ Descr ption:
& (77) {Pin 1 © TB{ RACK 00
& (77) {Pin 2} El FLOOR |sL073
& (?7) {Pin 3} © DI 120V INPUTS
& (77) {Pin 4} O DiStzrT
© MTR212 © DISC215
B O MTR216 © MTR208

Figure 2-49 The pin information of  Figure 2-50 The detailed information
the components of the component

Table 2-1 The significance of icons

AutoCAD Electrical component not linked to an Irventor component

Inventar compaonent not linked to an AutoCAD Electrical companent

Linked AutaCAD Electrical and Inventor components with no mismatches in data

Linked AutaCAD Electrical and Inventor components with some mismatch between the data

AutoCAD Electrical cable not linked to Inventor cable

Inventor cable not linked to AutoCAD Electrical cable

Linked AutoCAD Electrical and Inventor Cable with no mismatches in data

Mld|ex| 8|S (B |0

Linked AutoCAD Electrical Inventor cable with some mismatch between the data

When you right-click on an individual component node, a shortcut menu will be displayed, refer
to Figure 2-52. Choose the Surf option; the Surf dialog box will be displayed. In this dialog box,
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related references of the component are displayed. The options in this dialog box are discussed
in detail in Chapter 6.

- 9 =B .9 =1
] |Typehereto search... | #* |Typ-e here to search... |

NFPAdemo.swdp NFPAdemo.wdp
a8 77 B ()

7 7)

B FLeoe B FLOCR

IBHE @A

Expand all O Dise
Callapse all O Dis| €& Surf
O DISC

Figure 2-51 The shortcut menu displayed on  Figure 2-52 The shortcut menu displayed on
right-clicking on an installation/location node  right-clicking on a component node

Display Details and Connections
This button is used to expand the PROJECT MANAGER with two additional tabs: Details
and Connections. These two tabs are discussed next.

Details Tab

When you choose this tab, the Details pane is displayed. Choose the installation or location
node in the PROJECT MANAGER; a list of components in this node will be displayed in a grid
in the Details pane, refer to Figure 2-53. You need to scroll horizontally in the pane or increase
the size of the pane by stretching it horizontally to view all the columns in the grid. If you select
an individual component node in the PROJECT MANAGER, the tabular information of only that
component will be displayed in a grid.

x
" 9' C@ Details | Connections
% Type here to search.. Go | || @ Information updated at 4/13/2022 11:49:18 AM Export 2
NFPAdemo.wdp ﬂé
Tag Manufacturer  Catalog Number Description 1 Ten| =
= gFP(‘:f)em O | piscao7| a8 194E-A25-1753
@ O |DIsc211]AB 194E-A25-1753
B FLOOR < |DIsc215 | AB 194E-A25-1753
8 O DISC207 O | MTR208 | AB 1329RS-ZA00518VNH | CONVEYOR MOTOR H
j‘g(-’?’”"” i O |MTR212 | AB 1329RS-ZA00518VNH | HYDRAULIC MOTOR =
Xg:;iz:zg ©-|MTR216 |AB 1329RS-ZA00518VNH | INDEXING MOTOR 2
<% @) Ping) S B0 3
<& () Pin 5) ©-|PL207 _|HUBBELL MRMS22425
% (7 {Pin 6} < |PL211
- DIsC211 <C-|PL211  [HUBBELL MRMS22425
O DISC215 rERE
O MTR208 =
2 g <-|pL215_ |HUBBELL MRMS22425
O MTR216
O PL207: )]
» O PL207: [P]
& O pL211: )]
£ O PL211:[P]
g O PL215: )]
= O PL215: [P]
g JBOX1
g MACHINE
= MCABS
a

Figure 2-53 The Details pane with tabular information

If you right-click on the column name of the grid, a shortcut menu will be displayed, refer to
Figure 2-54. The options in this shortcut menu are used to add or remove columns from the
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Details pane and to restore default number of columns. Similarly, if you right-click on the cell(s)
or row(s) in the grid, a shortcut menu will be displayed, refer to Figure 2-55. This shortcut menu
consists of two options: Copy and Surf. The Surf option is already discussed in the Component
Tree. The Copy option will be activated only when you select cell(s) or row(s) in the grid. Using
this option, you can copy the content of the selected cell(s) or row(s).

% @ Details | Connections
Go 0 Information updated at 4/6/2021 10:52:22 AM

atalog Number Descripti
v | Tag
EE-AZS-W?SS
+ | Manufacturer hE-AZS-W?SS
+ | Catalog Number BE-A25-1753
+ | Description 1 DORS-ZA00518VNH | CONVEYOR b Go o Information updated at 4/5f20
~ | Terminal Strip PIRS-ZA00518VNH | HYDRAULIC I
2| item Number PIRS-ZAD0518VNH [ INDEXING M Tag Manufacturer
FeezmitiyCeila oo O lnieran7 L a B 1
Category C - _
q opy Crl+C
R © MS22425 - E :
More... @ Surf B 1
Restore all columns to defaults MS22425
TFTMTRPOBTAR 1

Figure 2-54 The shortcut menw displayed — Figure 2-55 The shortcut menu displayed on
on right-clicking on the column name right-clicking on the cell(s) or row(s) in the grid

The Export button located at the top right corner of the Details pane is used to export the
data in the grid to .xIs or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

Connections Tab

When you choose this tab, the Connections pane is displayed. Choose the installation or location
node in the PROJECT MANAGER; information about wiring of the components in this node
will be displayed in a grid in the Connections pane, refer to Figure 2-56. You need to scroll
horizontally in the pane or increase the size of the pane by stretching it horizontally to view all the
columns in the grid. If you select an individual component node in the PROJECT MANAGER,
the information regarding that component will only be displayed in the grid.

x —
I 9' e@ Details | Connections
#  Type here to search... Go | | @ Information updated at 4/13/2022 11:49:18 AM Export £
H
NFPAdemo.wdp =
Wire Number From Location From Component FromPin Tol o
=l
gFP(':‘f)“m” < |207a FLOOR PL207 : [1] 1 FLO(
o7 O [2078 FLOOR DISC207 FLOC
B FLOCR O-[2088 FLOOR DISC207 FLOC
8 O DIsc207 O |208A FLOOR PL207: 0] 2 FLOC H
j? (33) {Pin 1} O [208F FLOOR MTR208 FLOC =
3 E;Q; Eg:g g; o [208E FLOOR PL207: 11 3 FLOC s
& 02 Pin 4l O [211A FLOOR PL211:[)] 1 FLOC 3
<5 (??) {Pin 5} <2118 FLOOR DISC211 FLO(|
<5 (?7) (Pin 6} O |212F FLOOR MTR212 FLOC
O Disc211 O |212E FLOOR PL211:[1] 3 FLOC
w2 BEES O [2128 FLOOR DISC211 FLO(
©- MTR208 = :
o VTR O-[212A FLOOR PL211:[)] 2 FLOC
O MTR216 < [215A FLOOR PL215: [J] 1 FLOC
O PL207: 1)) O [2158 FLOOR DISC215 FLOC
» O PL207: [P] O |216F FLOOR MTR216 FLOC
] w2 LR (] O [216€ FLOOR PL215: [1] 3 FLOC
s O P21 [ O |2168 FLOOR DISC215 FLOC
= O PL215: )]
= O PL215: IP] < [216A FLOOR PL215: 1] 2 FLOC
2 JBOX1 < |208C FLOOR MTR208 FLOC
g MACHINE < |1212C FIOOR MTR?1? FlOC
= MCABS

Figure 2-56 The Connections pane with tabular information
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If you right-click on the column name in the grid, a shortcut menu will be displayed, refer to
Figure 2-57. The options in this shortcut menu are used to add or remove columns from the
Connections pane and to restore default number of columns. Similarly, if you right-click on
the cell(s) or row(s) of the grid, a shortcut menu will be displayed, refer to Figure 2-58. This
shortcut menu consists of two options: Copy and Surf. The Surf option is already discussed in
the Component Tree. The Copy option will be activated only when you select cell(s) or row(s)
in the grid. Using this option, you can copy the content from the selected cell(s) or row(s).

o Information updated at 4/13/2022 11:49:18 AM Export

Wire Nyzslaos—r — = rom Pin Tol
v )
o |207a Wire Number FLOC
o |2078 From Installation FLOC
O [2088 ﬂ From Location FLOC
O [208A ¥ | From Component FLOC
O l208F [ FromPin FLOC
O
Sl 3] L
O loe Y ToComponent FLOC @ information updated at 4/13/2022 11:4%:18 AM
. ¥ | Tolocation

O |21aF FLOC Wire Number From Location From Component From Pin
O |212E To Installation FLOC o 2074 fLoce [[p— 1
O [2128 More... FLOC O | 2078 FLON Copy  Ctrl+C
2124 Restore all columns to defaults FLO¢ O |2088 FLOC @ Suit
O-la1ca tinr

Figure 2-57 The shortcut menu displayed on Figure 2-58 The shortcut menu displayed on
right-clicking on the column names right-clicking on the cell(s) or row(s) of the grid

The Export button located at the top right corner of the Connections pane is used to export the
data in the grid to .x/s or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

(7

Note

1. Ifthe project you are working is an electromechanical project and you are linking it with Autodesk
Inventor, some additional buttons will be available in the PROJECT MANAGER such as Filter
the view by link status, Refresh the data from Inventor, and so on. Also, some additional
shortcut menu options will be available for the grid.

2. You can link AutoCAD Electrical component to the Inventor part or vice-versa. 1o do so,
right-click on Inventor part or AutoCAD Electrical part and choose Assign to Existing in
Component Tree from the shortcut menu displayed. The selected components will be linked with
some differences. You need to resolve these differences using the Details and Connections pane
in the Location View tab.

3. 1o insert connector from the Location View tab in the Inventor assembly of the electromechanical
project, right-click on a node or a connector and then choose Insert Connector (From List) from
the shortcut menu displayed.
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TUTORIALS
Tutorial 1

In this tutorial, you will create a new project and add project description to it, refer to Figure 2-59.
You will also create a new drawing in the project.

(Expected time: 10 min)

The following steps are required to complete this tutorial:

a. Create a new project.
b. Open the CADCIM project.
c. Create a new drawing.

Creating a New Project

1. Start AutoCAD Electrical 2023 by choosing Start > All Programs (or Programs, if you
are working with Windows XP Classic appearance mode) > Autodesk > AutoCAD
Electrical 2023 > AutoCAD Electrical 2023(Windows 7). Alternatively, double-click on the
shortcut icon of AutoCAD Electrical 2023 on the i PROJECT MANAGER
desktop of your computer to start AutoCAD ROECEER®-®
Electrical 2023. CADCIM ml

Projects - g

2. In the AutoCAD Electrical 2023 interface, #£7 capam =
choose the New button in the Start tab. The - EXTRA LIBRARY DEMO
PROJECT MANAGER is displayed by default %Eigg;ﬁowo
on the left of the screen. If it is not displayed, #£3 IECDEMO 2
choose the Manager tool from the Project 'E@'EEEDEMO 5
Tools panel of the Project tab. Alternatively, -E%ﬂigjg;no "l
choose the Project Manager tool from the T -

ACE:Main Electrical 2 toolbar to display the Sﬁ:':ccessible =T
PROJECT MANAGER. File Name: CADCIM.wdp
Location: C:\Users\CADCIM1

3. In the PROJECT MANAGER, make sure the oy s Aebere
Projects tab is chosen. Next, choose the New
Project button; the Create New Project dialog P e
box is displayed, as shown in Figure 2-60. \AUtoCAD Electrical 2023\R24.2\enu

\Support\user\CADCIM.mdb

4. Enter CADCIM in the Name edit box. e T:cADCM

Title 2: AutoCAD Electrical
Title 3: Sample Project

5. Choose the Browse button; the Browse For g’;:jﬂ’}ﬂm
Folder dialog box is displayed. By default, the Engineer: Sham v
Proj folder is selected in this dialog box. Choose

the OK button; the location of the project is Figure 2-59 The PROJECT MANAGER
automatically displayed in the Location edit box. displaying the CADCIM project and. its

description
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Create New Project X

Name:

Location
‘C:\Users\CADCIM]\Documents\AcadE 2023\AeData\proj\ | Browse...

Create Folder with Project Name

Ci\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\

Copy Settings from Project File
C:\Users\CADCIMT\Documents\AcadE 2023\AeData\projiNFPAdemo\NFPAdemo.wdp Browse

Descriptions..

OK - Properties... QK Cancel Help

Figure 2-60 The Create New Project dialog box

6. Select the Create Folder with Project Name check box, if not selected.

7. By default, the name and path of the existing project is displayed in the Copy Settings from

Project File edit box as C:\Users\User Name\Documents\Acade 2023\AeData\proj\NFPAdemo)
NFPAdemo.wdp. 1f it is not displayed, choose the Browse button; the Select Project File
dialog box is displayed. Select the NFPADemo folder and then select the NFPAdemo.wdp
project file.

Next, choose the Open button; the path and name of the existing project is displayed in
the Copy Settings from Project File edit box.

Choose the Descriptions button from the Create New Project dialog box; the Project
Description dialog box is displayed.

Enter the following information in the Project Description dialog box, as shown in
Figure 2-61.

LINEl= CADCIM
LINE2= AutoCAD Electrical
LINE3= Sample Project

LINE4=1

LINE5= 14/04/2022
LINE6= Sham
LINE7= John
LINE8= Crystal
LINE9= 1.00

Next, select the in reports check box corresponding to each of these lines to include this
description in the reports, refer to Figure 2-61.
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Project Description (for report headers and title block update)

Linel

Line2

Line3

Line4

Line5

Line6

Line?

Lined

Lined

Line10

Linel1

Line12

. Note
@ The information that you enter in the description lines of the Project Description dialog box will

|CADCIM

| |n reports

|AquCAD Electrical

| [~inreports

|Samp\e Project

| [«lin reports

|1

| Dln reports

[14/0472022

| [inreports

|Sham

| [linreports

|Juhn

| DIH reports

|Crysta\

| [inreports

|1m

| [linreports

| DIH reports

| [inreports

| DIH reports

Cancel

Figure 2-61 The Project Description dialog box

>l

be displayed at a particular location in the title block of the drawing files of the CADCIM project,

as shown in Figure 2-62. The title blocks will be discussed in detail in Chapter 12.

10. Choose the OK button from the Project Description dialog box to save the changes made

in this dialog box.

11. Choose the OK button from the Create New Project dialog box. You will notice that
the CADCIM project appears in bold text at the top of the project list displayed in the

PROJECT MANAGER, refer to Figure 2-63.

12. Next, select the CADCIM project from the PROJECT MANAGER.

13. Choose the Details button from the Details/Preview rollout. You will notice that the project
description/information entered in the first nine lines of the Project Description dialog box
is displayed in the Details/Preview area, as shown in Figure 2-63.

Note

1. It is recommended to save all the tutorials in the forthcoming chapters in the CADCIM project.

2. If the CADCIM project is not displayed in the Projects rollout of the PROJECT MANAGER,

select the Open Project option from the Project selection drop-down list; the Select Project

File dialog box is displayed. Select the Proj folder from the Look in drop-down list and then
double-click on the CADCIM folder name. Next, select the CADCIM file and choose the Open
button; the CADCIM project is displayed in the Projects rollout and it becomes the active project.
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Figure 2-62 The title block showing the Figure 2-63 The PROJECT MANAGER
description entered in the Project Description  displaying the CADCIM project and its description
dialog box

Creating a New Drawing

1.

In the PROJECT MANAGER, choose the New Drawing button; the Create New
Drawing dialog box is displayed, as shown in Figure 2-64.

Enter C02_tut01 in the Name edit box. Next, choose the Browse button; the Select
template dialog box is displayed. In this dialog box, select ACAD_ELECTRICAL.dwt from
the list displayed and then choose the Open button; the name and path of the template is
displayed in the Template edit box.

Clear the For Reference Only check box, ifit is selected. Next, choose the Browse button
available on the right of the Location edit box; the Browse For Folder dialog box is displayed.
By default, the CADCIM project is selected. Choose the OK button; the location of the
drawing is automatically displayed in the Location edit box.

Enter 3 Phase Motors in the Description 1 edit box.

Enter Motor Control Circuit in the Description 2 edit box and enter 01 in the Drawing
edit box of the Sheet Values area.

Choose the OK button from the Create New Drawing dialog box; you will notice that
the drawing that you created gets added to the active project. To view the drawing that
you created, double-click on CADCIM in the PROJECT MANAGER; the drawing list is
displayed and the drawing C02_tut01.dwg appears in bold text in the PROJECT MANAGER.
In this case, the active project is CADCIM and therefore, the drawing gets added to this
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project. Click on the drawing; the details and the preview of the drawing are displayed in
the PROJECT MANAGER, as shown in Figures 2-65 and 2-66.

Create New Drawing x

Drawing File
Name: | |

Template: | | Browse..

["|For Reference Only

Location: |C\UserS\CADCIM1\Documents\AcadE 2023\AeData\proj\CADCIM | Browse..

C\Users\CADCIM1\Documents\AcadE 2023\AeData\proj\CADCIM

Description 1: | V|
Description 2: | V|
Description 3: | v|

IEC - Style Designators
Project Code:

Installation Code:

| | Drawing... Project...

Location Code:

| | Drawing Project.

SheetValues

Sheet | | Section: | w |

Drawing: | | Sub-Section | ~ |
OK - Properties... OK Cancel Help

Figure 2-64 The Create New Drawing dialog box

Details E
Status: Accessible
Sheet:

Description: 3 Phase Motors
Description: Motor Control Clrcuit
Description:

Preview B v

File Name: C02_tut01.dwg

Location: C\Users\CADCIM1
\Documents\AcadE 2023\AeData
\proj\CADCIM

File Size: 49KB (50404 bytes)
Last Saved: 4/13/2022 3:33:27 PM
Last Edited By: CADCIM1

Figure 2-65 The Details rollout displaying ~ Figure 2-66 The Preview area displaying
the description of CO2_tut01.dwg the preview of CO2_tut01.dwg
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Tutorial 2

In this tutorial, you will add and remove drawings from the CADCIM project and replace the
drawings of the POINT2POINT project with the CADCIM project that you created in Tutorial 1
of this chapter. (Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Add drawings from the existing project.
Remove the drawing.
c.  Replace the drawing.

Adding Drawings from the Existing Project
1. Right-click on the CADCIM project; a shortcut menu is displayed. Choose the Add Drawings
option from the shortcut menu; the Select Files to Add dialog box is displayed.

2. In this dialog box, select the c:\Users\User Name\Documents\Acade 2023\AeData\proj\ folder
from the Look in drop-down list; a list of all the projects saved in this folder is displayed.
Next, double-click on the NfpaDemo folder =
from the Select Files to Add dialog box; the W BEECEBR®-

drawings present in this folder are displayed. | oo - g
Projects A g
=-ER A
3. Press SHIFT/CTRL and select the DEMOOI, 7 Df:[;ﬂumdwg
DEMOO02, DEMOO03, DEMO04, and DEMOO05 & DEMO01.DWG
drawings. Next, choose the Add button; the ; gimgggmg :
Apply Project Defaults to Drawing Settings I p———— E
message box is displayed. % DEMOOS.DWG g
) E_D EXTRA LIBRARY DEMO ~
- E‘DGBDEMO .

4. Choose the Yes button from this message m PR ircengaznnn

E‘X‘Séﬁi;elec.ted dra‘;l‘ngs ?‘reF?‘ddethg7the Figure 2-67 The PROJECT MANAGER
project, as shown in Hgure 2-67. displaying the CADCIM project with the

. . drawings added to it
Removing the Drawing

1. Right-click on the DEMOO1.dwg drawing and then choose the Remove option from the
shortcut menu displayed; the PROJECT - Manager Remove Files message box is displayed.
Choose the Yes button in this message box; the DEMO01.dwg drawing is removed from the
drawing list, see Figure 2-68.

Replacmg the Drawing
To replace the DEMO02.dwg drawing of the CADCIM project with the Connector.dwg of
the POINT2POINT project, right-click on the DEMO02.dwg drawing; a shortcut menu is
displayed. Choose the Replace option from the shortcut menu; the Select Replacement
Drawing dialog box is displayed.

2. Select the Proj folder from the Look in drop-down list. Next, double-click on the Point2Point
folder; the Connectordwg drawing is displayed in the Select Replacement Drawing dialog
box.
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3. Select the Connectordwg drawing from this dialog box and choose the Select button; the
Apply Project Defaults to Drawing Settings message box is displayed. Next, choose the
Yes button; the DEMO02.dwg is replaced with the Connector.dwg drawing in the CADCIM
project, as shown in Figure 2-69.

X
W BEECE DR N ROECERRG®-

# CADCIM - oz ¥ CADCIM - =
© 5
Projects - =3 Projects - =
o o
=-C capcim ~ =% capaim
2§ C02_tut01.dwg -5 C02 tuto1.dwg

+.-B§ Connector.dwg

DEMOO3.DWG
DEMOO4.DWG
+-B§ DEMO05.DWG
&% EXTRA LIBRARY DEMO
-4 GBDEMO

&+ IEC60617DEMO

o Pa

| DEMO02.DWG

[ DEMO04.DWG
.. ¥% DEMO05.DWG
&3 EXTRA LIBRARY DEMO
-3 GBDEMO
-7 IEC60617DEMO

v e (B e eravarn =
s

Location View
Location View

v

Figure 2-68 The PROJECT MANAGER Figure 2-69 The PROJECT MANAGER displaying
displaying the CADCIM project after removing  the CADCIM project with the DEMOO2.dwg drawing
the DEMOO1.dwg drawing replaced by the Connector.dwg drawing

Tutorial 3

In this tutorial, you will create a subfolder within a CADCIM project and configure the drawing
list display for this project. (Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Create a subfolder.
b. Configure the drawing list display.

Creating a Subfolder
In this section, you will create a subfolder in the CADCIM project that is created in Tutorial 1.
1. Make sure that the CADCIM project is activated x _
) ‘ : W ERECEHBER®-
in the PROJECT MANAGER. Next, right-click | [ B
on it; a shortcut menu is displayed. oroi g
rojects = g
=-C74 capcim
2. ChOOSC the Add Subfolder OptiOIl from the #S Connector.dwg
shortcut menu; a subfolder with the name NEW = gimggﬁmg
FOLDER is created within the CADCIM project. I§ DEMOO5.DWG Z
Rename it as TUTORIALS. & {71 TUTORIALS 5
-1§ €02 tut01.dwg =
. &2 EQ) EXTRA LIBRARY DEMO 5
3. Drag and drop the CO2_tut0I.dwg drawing =3 6BDEMO 5
created in Tutorial 1 on the TUTORIALS s SR

subfolder; the C02_tut01.dwg drawing ismoved to  Figure 2-70 The CO2_tut01.dwg moved
the TUTORIALS subfolder, refer to Figure 2-70. ¢ the TUTORIALS subfolder
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Note

1. In AutoCAD Electrical, all projects and its subfolders names are displayed in wppercase.

2. You can collapse the CADCIM project by right-clicking on its name and choosing the Collapse
All option from the shortcut menu displayed.

COnflgurmg the Drawing List Display

Choose the Drawing List Display Configuration button from the PROJECT MANAGER,;
the Drawing List Display Configuration dialog box is displayed. You will notice that only
the File Name is displayed in the Current Display Order area.

Select Drawing Number(%D) from the Display Options area and then choose the >>
button; Drawing Number(%D) is moved to the Current Display Order area. Similarly,
select Drawing Description 1 from the Display Options area and choose the >> button;
Drawing Description 1 is moved to the Current Display Order area. Next, choose the OK
button to close the Drawing List Display Configuration dialog box.

You will notice that drawing numbers are added to the first four drawings in the CADCIM
project and description is added to the C02_tut01.dwg.

Tutorial 4

In this tutorial, you will copy an existing project with the name Copy_Point2Point and add
three drawings into it. Next, you will find the list of drawings that have different settings. You
will also compare and match the settings of one of the added drawings with the copied project.

C.

(Expected time: 15 min)
The following steps are required to complete this tutorial:

Copy the Point2Point project.
Add the drawings.
Find the Exception list and compare the settings.

COpymg the Point2Point Project

Choose the Copy tool from the Project Tools panel of the Project tab; the Copy Project:
Select Existing Project to Copy dialog box is displayed, as shown in Figure 2-71.

In this dialog box, choose the Browse button located next to the Enter existing project path
edit box; the Open dialog box is displayed. In this dialog box, select the ¢:|Users\User Name\
Documents\Acade 2023\AeData\proj| folder and then double-click on the Point2Point folder.
Next, select the Point2Point.wdp file, refer to Figure 2-72. Now, choose the Open button;
path of the Point2Point.wdp file is displayed in the Enter existing project path edit box.

Make sure the Use Selected project as template project check box is selected. Now, enter
Copy_Point2Point in the New project name edit box. You will notice that the location of
the project to be copied is updated in the New project location edit box.
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ﬂ Copy Project: Select Existing Project to Copy X

. : Use Active Project
Enter existing project path

C\Users\CADCIM1\Documents\AcadE 2023\AeData\pro\CADCIM\CADCIM.wdp E
Use selected project as template project

New project name
CADCIM - copy.wdp

New project location
C\Users\CADCIMT\Documents\AcadE 202\AeData\prof\CADCIM - copy E

MNote: If one or more drawings are open in the project that's to be copied to a new project, these drawings will be saved.

| oK | ‘ Cancel ‘ ‘ Help ‘

Figure 2-71 The Copy Project Select Existing Project to Copy dialog box

B open x
« v 1 « Acade 2023 > AeData > Proj > Point2Point v [$] O Search Point2Point
Organise ~  New folder = - O @
A
® This PC

~# 3D Objects.

[ Desktop .
@ Documents

¥ Downloads Point2Point
b Music

&= Pictures

m Videos

% Windows (C)
v

Point2Point Rating: Date created: 1/21/2014 8:32 AM
WDP File Size: 1.44 KB Date modified: 1/21/2014 832 AM
File name: |Puin12Puint V| ‘Electrical Project Files |

Cancel
Figure 2-72 The Open dialog box

4. Choose the OK button in the Copy Project: Select Existing Project to Copy dialog box; the

Copy_Point2Point project is added to the Projects rollout of the PROJECT MANAGER.
Also, the drawings in the Copy_Point2Point project get saved in its project folder and this
project becomes an active project.

Adding the Drawings

1.

Right-click on the Copy_Point2Point project in the PROJECT MANAGER; a shortcut menu
is displayed. Choose the Add Drawings option from the shortcut menu; the Select Files to
Add dialog box is displayed.

In this dialog box, choose the Up one level button; the Proj folder is displayed in the Look
in drop-down list. Next, double-click on the NfpaDemo folder; the drawings present in this
folder are displayed. Press SHIFT/CTRL and select the DEMOO07, DEMOOS, and DEMO09
drawings.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Choose the Add button; the Apply Project Defaults to Drawing Settings message box is
displayed.

Choose the No button from this message box; the selected drawings are added to the
Copy_Point2Point project, as shown in Figure 2-73. If the drawings are not displayed in
the Copy_Point2Point project, choose Refresh from the PROJECT MANAGER.

Finding the Exception List and Comparing the Settings
1.

Right-click on the Copy_Point2Point project and
choose Exception List from the shortcut menu
displayed; the Properties Exception List: e
COPY_POINT2POINT dialog box is displayed, as =

= . . . . =-[[ COPY POINT2POINT ~ ~
shown in Figure 2-74. This dialog box lists the | _F% Connector.dwg - W12
drawings which have different properties than the . - DEMO07.0WG - 0207
project default properties. Next, choose the OK .~ DEMO0BDWG - 0208

. .. . BN DEMO09.DWG - 0209
button in this dialog box. PA CADOM

3 EXTRA LIBRARY DEMO
N i

REOECE BR®-
COPY_POINT2POINT -

Select the Connector.dwg from Copy_Point2Point
in the Projects rollout and right-click; a shortcut Figure 2-73  The Copy_Point2Point
menu is displayed. Choose Properties from the project with the drawings added to it
shortcut menu; a cascading menu is displayed.

Choose Settings Compare from the cascading menu; the Compare Drawing and Project
Settings: Connector.dwg Versus COPY_POINT2POINT dialog box is displayed, as shown
in Figure 2-75.

Properties Exception List: COPY_PQINT2POINT s

. These drawing(s) have different properties than the project defaults. Use the Settings Compare
!“‘ function to display differences.

—

File Name: Connector.dwg
Status: Locked by CADCIM1(CADCIM)
Location: C:\Users\CADCIM1\Documents\Acade 2023\AeData\Proj\Copy_Point2P oint

File Name: DEMOO7.DWG
Status: Accessible
Location: C:\Users\CADCIM1\Documents\Acade 2023\AeData\ProjiNfpaDemo

File Name: DEMO08.DWG
Status: Accessible
Location: C:\Users\CADCIM1\Documents\Acade 2023\AeData\ProjiNfpaDemo

File Name: DEMO09.DWG
Status: Accessible
Location: C:\Users\CADCIM1\Documents\Acade 2023\AeData\ProjiNfpaDemo

Figure 2-74 The Properties Exception List: COPY_POINT2POINT dialog box

You will notice that this dialog box displays the number of drawing settings that are
different from its project. First entry in this dialog box indicates that component tags of the
Connector.dwg are reference based and component tags of the Copy_Point2Point project are
sequential in order.

Select the first entry and choose the Match Drawing button from the Compare Drawing
and Project Settings: Connector Versus COPY_POINT2POINT dialog box. Next, choose
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OK; the component tag settings of the project are matched with the Connectordwg file. To
confirm this, repeat step 2. You will notice that component tag settings are not displayed
any more in the list.

| Compare Drawing and Project Settings: Connector.dwg Versus COPY_POINT2POINT X

. (O showAl
! @\é‘haw“D'i'ﬁé'ré'ﬁé'e; SelectAll Match Project Match Drawing
| Settings Description Drawing Project
| Component tags: R=reference, S=sequential based R S
Wire layers WIRES® 20A" 22A" 18A" 16A” 1|\ WIRES
| [¥REF_GRAPHIC 1 0
|

Figure 2-75 The Compare Drawing and Project Settings: DEMO007.DWG
Versus COPY_POINT2POINT dialog box

Tutorial 5

In this tutorial, you will surf a component and extract component information and connection
details of the CADCIM project to an external file using the Location View tab in the PROJECT
MANAGER. (Expected time: 15 min)

The following steps are required to complete this tutorial:

Surf the component.
Extract component information.
Extract connection details.

Surfing the Component

1.

Make sure the CADCIM project is activated. Choose the Location View tab from the
PROJECT MANAGER. Next, choose the CADCIM node from the PROJECT
MANAGER. Next, choose the Display Details and Connections button; the PROJECT
MANAGER is expanded with the Details tab activated, as shown in Figure 2-76.

You will notice that the component information is displayed in the Details pane in the grid.

Scroll down in the PROJECT MANAGER and select LS406 from the Tag column. Next,
right-click on it; a shortcut menu is displayed, as shown in Figure 2-77.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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x
w9

# | Type here to search...
CADCIMwdp
CADCIM

@ PROJECT MANAGER

C‘@ Details | Connections

Go | | @ Information updated at 4/14/2022 11:52:21 AM

Export

Tag  Manufacturer Catalog Number Description 1 Terminal Strip ~ Item Number
O b1 D SUB 9 PIN:1
o|p1 D SUB 9 PIN:1
o2 D SUB 15 PIN:1
O b2 D SUB 15 PIN:1
4 Ds1_[ALPHA 179C D SUB CABLE
O-|GND310
O-|GND312
O-|GND314]
Ol MOLEX_SL_MALE_10_PIN:2
o MOLEX_SL_MALE_10_PIN:2
o3 MOLEX_SL MALE 4 PIN:1
o3 MOLEX_SL_MALE 4 PIN:1
O TRANSFORMER:1
e TRANSFORMER:1
o5 MOLEX_SL_MALE 4 PIN:2
ois MOLEX_SL_MALE 4 PIN:2
o2 MOLEX_SL MALE_10_PIN:1
o2 MOLEX_SL_MALE_10_PIN:1
olp1 CN3_MATE:1
o1 CN3_MATE:1
Olp2 CN3_ MATE2
O[p2 CN3_MATE2
O-|pLcs03 |ag 1771-1AD RACK 00 29

Figure 2-76 Expanded PROJECT MANAGER

Projects

Location View

3. Choose Surf from the shortcut menu; the Surf dialog box is displayed, as shown in
Figure 2-78. Choose Go To from the Surf dialog box; the demo004.dwg file opens with LS406

zoomed in.

o SIEMENS 8\
Q M3 M
O [Ls40 Copy Ctrl=C

Q| Ls40

S5 Toet o Surf

O | PRSS04 |EATON E:
O IPRSS05 |EATOMN ES

Figure 2-77 Shortcut menu displayed

Note

Surf X
LS406 references
Manufacturer:
Catalog:
Type SheetReference  Installation Location Cat
p NO 4,406 MACHINE
< >
Show more
Freshen Edit Catalog Check Pan
Zoom Save Delete Pick Mew List ZoomIn
Zoom Out
GoTo Close Help
= )

Figure 2-78 The Surf dialog box

The options in the Surf dialog box are discussed in detail in Chapter 6.

Extracting the Component Information
1. Right-click on the Tag column in the grid; a shortcut menu is displayed. Choose More from
this shortcut menu; the Columns to display dialog box is displayed.

2. Scroll down in the Columns to display dialog box and select the Category, Ratingl, Location
and Terminal Number check boxes, as shown in Figure 2-79. Next, choose OK; the Category,
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Ratingl, Location and Terminal Number columns

L. . ﬂ Columns to display x
are added to the grid in the Details tab.

Item Number

3. Choose Export from the PROJECT MANAGER,; [] Assembly Code
the Save As dialog box is displayed. Browse to c:.\ Category
Users\User Name\Documents\Acade 2023\AeData\proj) )
CADCIM and choose Save; the ComponentDetails.csv Rating 1
file is saved at the specified location. [ Rating 2
[V Terminal Number
Extracting the Connection Details [] Description 2
1. Choose the Connections tab in the l"ROJIjZCT [] Description 3
MANAGER; the PROJECT MANAGER is modified ]
with connection details of the CADCIM project L] instalation
displayed in the grid. [ Location
2. Right-click on the Wire Number column in the grid; ok | [ Cancel |
a shortcut menu is displayed. Choose More from this
shortcut menu; the Columns to display dialog box  Figure 2-79 The Columns to display
is displayed. dialog box
3. Scroll down in the Columns to display dialog box and select the Wire Type, Wire Color,
and Wire Gauge check boxes. Next, choose OK; the Wire Type, Wire Color, and Wire
Gauge columns are added to the grid in the Connections tab.
4. Choose Export from the PROJECT MANAGER; the Save As dialog box is displayed.

Navigate to c:\Users|\User Name\Documents\Acade 2023\AeData\proj\CADCIM and choose Save;
the ConnectionDetails.csv file is saved at the specified location.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1.

Which of the following buttons in the PROJECT MANAGER is used to execute the pending
updates?

(a) New Project (b) Refresh
(c) Project Task List (d) Surfer

The option is used to plot all drawings of a project or a specified group of
drawings.

The option is used to create copies of an existing project with all the drawings
and related files.

The dialog box is used to edit the properties of a drawing.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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5. Choose the button to preview a selected drawing.
6. You can add up to lines of description per page for each drawing in a project.
7. A project file is an ASCII text file. (T/F)
8. The PROJECT MANAGER is used to manage the project files only. (T/F)
9. A project file always consists of drawings placed in a single directory. (1/F)
10. You can switch between sequential drawings in an active project. (1/F)
Review Questions
Answer the following questions:

1. Which of the following buttons is used to change the appearance of a drawing list displayed
in the PROJECT MANAGER?

(a) Plot Project (b) Project Task List
(c) Move Up (d) Drawing List Display Configuration

2. Which of the following options is used to add existing drawing(s) to a project?

(a) Descriptions (b) Add Active Drawing
(c) Add Drawings (d) Title Block Update

3. The Remove Drawings option is used both for removing and deleting a drawing file. (1/F)
4. You can close only the non-active projects. (1/F)

5. Projects can be closed by using the Project selection drop-down list. (1/F)

EXERCISES
Exercise 1

Create a new project with the project name NEW_PROJECT and add appropriate description to
it. (Expected time: 10 min)

Note
It is recommended to save all exercises of the forthcoming chapters in the NEW_PROJECT project.

Exercise 2

Create a new drawing with the name C02_exer02.dwg in the project created in Exercise 1 and
add appropriate description to it. (Expected time: 10 min)
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Exercise 3

Using the Copy button, create a new project with the name COPY_PROJECT containing the
drawings and settings of any existing project. (Expected time: 10 min)

Answers to Self-Evaluation Test
1. C, 2. Plot Project, 3. Copy Project, 4. Drawing Properties, 5. Preview, 6. three, 7. T, 8. F,
9.F,10.T
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